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SECTION 1:  INTRODUCTION

Aide De Camp Version 2.0 (ADC2) is a computer game aid designed to let players draw, set up, play, and 

store any board, map, or card game.  Game designers can also use ADC2 as an “electronic easel” for the 
development games from scratch.  Essentially, with ADC2, the user is creating an electronic version of his 
or her favorite board and card games.  

ADC2 includes built-in routines for common game functions, such as movement and combat.  It has a dice-
rolling function (any-sided) and the ability to utilize hidden pieces.  However, it does NOT contain any 
rules, maps, or other information for specific games.  Therefore, you must own a copy of a board game in 
order to be able to use ADC2 to play that game.

Because of ADC2’s enormous flexibility, it can handle a wide variety of games.  The screen graphics, map 



layout, complexity, and overall look and feel of the gameset created is determined by the user (the term 
gameset refers to the ADC2 version of the board game).  In general terms, a “functional” gameset can 
usually be created fairly quickly.   Making gamesets that are “gorgeous”, however, can take some work. 

So, the final result  just depends on how much effort you want to put into it.

After installing ADC2, select the First Time Help button from the Control Panel screen.  This slide show 
will walk through the steps necessary to use ADC2, and is always available.

Once you’re off and running, the on-line help is always available to assist you.

Enhancements to ADC1

With many enhancements and the switch to Windows 95, ADC2 represents a major step forward from 
ADC1.  Owners of  ADC1 will find many similar procedures, but will also be delighted by the new 
additions such as the full 16 million color palette, scanned map import capability, hidden pieces, and much 
more.  The key question for ADC1 owners  is “Are my old gamesets still usable?”  Fortunately, the answer 

is “Yes!”  ADC2 contains a conversion utility that will convert ADC1 games for use with ADC2.  For more 
information, click the ADC1 Upgrade button from the ADC2 Control Panel.

Copyrights

HPS Simulations makes no representations concerning the copyrights and other interests held by the board 
game publishers.  It is not an infringement of the publisher’s right if an owner of a board game places the 
game on ADC2 for his or her personal use to play the game.  Nor is it an infringement if the owner of the 
board game uses ADC2 to play that game with another individual or individuals.  But, at least one person 

playing the game must own a copy of the board game.  When play is completed, the ADC2 copies of the 
board game in the possession of persons who do not own the board game should be erased or returned. 
Further, board games or portions thereof entered on ADC2 must not be distributed or sold without the 
permission of the game’s publisher and HPS Simulations.

To avoid copyright violations, just think of how games are played without ADC2.  A copy of the board 
game is set up in one location, and then any number of people can participate, even if they themselves do 
not own the game.  But when the game ends, only the owner should return home with the board game.  At 

the start of the game there was one copy of the game, and at the end there is one copy.  It should be the 
same if you use ADC2.

As for the ADC2 program, it is licensed to the original purchaser only, for use on a single computer.  The 

original purchaser may make back-up and archive copies of ADC2, but may not sell or give away the 
ADC2 program to others.  If more than one person will be playing a game with ADC2, all players must 
own ADC2, or all use the same copy of ADC2 located on the original purchaser’s computer.

Additional copyright information and terms are detailed under Help | About.

SECTION 2:  COMPUTER REQUIREMENTS and INSTALLATION

ADC2 requires Windows 95/98 or better as the operating system.  A minimum of a 486/66 processor  is 

recommended.  Additionally, ADC2 requires the 16bit High Color screen resolution mode (this is set by 
clicking the Start button from the taskbar, followed by  Settings | Control Panel | Display | Settings). 
Minimum RAM is 8 megabytes, with 16 recommended.

To install ADC2, place the CD-ROM into your hard drive.  On some systems, the installation will 
automatically begin.  Otherwise, run “INSTALL” from your CD-ROM drive.  Follow the install program’s 
instructions.

Subdirectories

ADC2 will create a directory (folder) called ADC2 in whatever hard drive  (C: for example) you specify. 
In addition to the main ADC2 directory, it will create several subdirectories (folders).  They are:



ADC2/Pictures ( .bmp files used in replays)
ADC2/Sounds ( .wav files used in replays)
ADC2/Game Sets( gameset and Play Game (.ops) files)

ADC2/Player Pics ( player .bmp files, or custom .bmps)
ADC2/Video Clips (.avi video files used in replays)
ADC2/Program Files (program files)
ADC2/First Timer (slide show)

If you change these subdirectory (folder) names, verify that the main program will find and recognize them.

SECTION 3: DEFINITIONS

Cards:  Cards in ADC2 function as they do in actual games and exist in a deck, hand, or on the mapboard. 

Card graphics are made as “piece symbols” in the Symbol Editor Module, for the card back and 
the faces of the individual cards.  Once a deck’s symbol set has been completed, it is turned into a 
deck of cards in the in the Play Game Module. 

Classes: Classes are notional objects that are the basis for all playing pieces. Their only purpose is to be 

used as the building blocks for pieces. They do not exist on the game mapboard or in pools, i.e., 



you never move a class on the mapboard.  The class consists of the piece symbol, a class name (of 
up to 25 characters), the player (or nationality) of the class, the type of facing used (if any) and the 
Hidden Unit symbol used for this class (if any), and up to 8 Class Values (see below).  In typical 

boardgaming terms, a class is a group of playing pieces which share the same values and 
characteristics.  For example, you might have a boardgame with a dozen infantry brigade counters 
with identical combat and movement factors, let's say 4-6.  The concept of a “4-6 Infantry 
Brigade” is a Class in ADC2 terminology.  The 12 physical cardboard counters are members of 

the class, and are called Pieces in ADC2 terminology (see below).   Classes are created in the Play 
Game Module by combining a unit symbol with a specific class name.  See Appendix B for 
further explanation.

Class Values:  Each defined Class (see above) can have up to 8 specific attributes or values assigned to it. 

These values are edited in the Play Game Module, and may be changed at any time during a game, 
but doing so changes the values for all pieces that use that class. Therefore it is unlikely that Class 
Values will be changed once a game begins.  Examples of typical Class Values are things like the 
Attack Factor, Defense Strength, Movement Factor/Rate, Range, FLAK factor,  etc.   Class Values 

are definable as text (up to 4 characters per value), numbers (0-9999), or yes/no.  Each of the eight 
Class Values can be given a unique name of up to 15 characters, however the names are shared 
among all the defined Classes.  Separate Classes must be defined for both the front and back side 
of a game piece which can be "flipped."

Click:  Pressing the left mouse button.
Combat Flag:  The combat flag indicates whether or not a piece has engaged in combat in the current turn 

(or, since the flags were last cleared).  These flags appear at various places in the Play Game 
Module, including the Piece Information Window at the bottom left of the main screen, and in the 

Select Pieces for Action window.  An “A” flag indicates the piece participated as an attacker, a 
“D” indicates it defended (was the object of an attack).  In some cases, a “C” is used to indicate it 
was either an attacker or defender (or both).  You can clear/reset,  the flags from the main menu: 
Game | Advance/Set Turn.  

Force Pool: Pools are off-map holding areas for pieces.  Think of them as a storage tray that you have 
organized to hold your boardgame counters.  Pools can also serve as the “boxes” around the main 
playing area of mapboard sometimes used in actual boardgames to place counters.

Gameset:  The complete group of ADC files that represent a specific game.  A gameset normally includes 

the symbol set (map and piece graphics), the map, and an initial “setup” turn.
Hex:  A grid shape used to regulate piece placement and movement in many board games.  In ADC2, it is a 

general term that applies to a single, indivisible,  Mapboard location into which graphics and 
pieces can be placed. 

Hex Grain: The grain describes the orientation of the hex grid on the mapboard.  To tell which grain is 
appropriate for a game, position the actual (paper) mapboard as you would like to view the playing 
area in ADC2.  If the flat sides of the hexes are on top  (the hexes are in columns),  it is a vertical 
hex grain.  If the apexes (angles) are on top (the hexes are in rows), it is a horizontal hex grain. 

Hex grain is only used for maps with a hex or offset square grid.  
HexLine: Hexlines are linear features which radiate out from the center of a hex. They are placed in the 

Mapboard Editor Module to graphically represent things such as roads, railroad lines, in-hex 
rivers, etc.

HexSide: Hexsides are linear features located at the interface between two hexes.  They are placed in the 
Mapboard Editor Module to graphically represent features such as rivers and borders.

Map Style: The style defines whether an the Mapboard will use hexes or a grid, i.e., hexes like a typical 
wargame or squares like a chess board.

Mapboard:  The complete playing surface of an ADC2 game is called the Mapboard.  It may be composed 
of adjoining hexes or rectangles (see above), each of which represents an indivisible location for 
placing graphics and pieces.   Each of these locations is generally referred to as a “hex” (NOTE: 
ADC1 has a 30,000 hex limit.  With ADC2, the limit is 60,000).  Each map hex or square always 

has a primary Mapboard symbol type (the default is the first symbol entered).  Additionally, hexes 
may have any number of secondary symbol characteristics.  For example, a hex may have a 
primary symbol of woods, and secondary symbol of a port and a factory.  On the screen, this 
might look like a black anchor symbol and a factory symbol on a green background.  Finally, a 

hex may have features such as roads, rivers, etc., which are noted by hexlines and hexsides. 



Mapboards are created in the Mapboard Editor Module.
Mapboard Symbols:  These are symbols created using the Symbol Editor Module which are then used to 

create the Mapboard.  ADC2 allows for hexagonal based maps, square grid maps, and/or 

geomorphic variations of these.  “Area” type maps are built by either using a different “color” of 
primary symbol in each area’s component hexes, or by enclosing each area with hexsides or 
hexlines. 

Mapsheet:  Many board games use multiple mapsheets to produce the total playing area, each of which 

normally has its own name and numbering system.  The mapsheet capability of ADC merely 
matches this situation, where each ADC mapsheet corresponds to one paper mapsheet.  This 
allows users to insure that hex numbering in their ADC game matches the paper game.  ADC 
games always contain at least one mapsheet, even if they are pure card games.  If the user doesn’t 

enter any mapsheets of his own, ADC2 assigns the game one with a default numbering scheme. 
Menu Bar: The items at the top of the screen
Movement Flag: The movement flag indicates whether or not a piece has moved in the current turn (or, 

since the flags were last cleared).  This flag appears as the letter “M” at various places in the Play 

Game Module, including the Piece Information Window at the bottom left of the main screen, and 
in the Select Pieces for Action window.  You can clear/reset,  the flags from the main menu: 
Game | Advance/Set Turn.  

*.Ops File:  The “OPS” file is created by the Play Game Module when a game is saved.  It stores all of the 

current game and turn data, including classes, pieces, pools, players, the replay, and other 
information.  It is usually named after the game or a specific scenario of a game (i.e., “War of the 
Worlds Turn 1.OPS”).  The OPS file is what is sent to the other players at the end of each turn 
when playing a game via PBEM.

Pieces:  Pieces are unique individual objects that represent the actual playing pieces (“units” or “counters” 
in wargaming parlance) , and can exist either in Pools or on the mapboard.  Pieces must belong to 
a Class (see above), which, among other things, determines the symbol which will appear on the 
mapboard.  Pieces may also have a name (of up to 25 characters in length) and up to eight Piece 

Values (see below) assigned to them.  Pieces are created from the existing classes when they are 
initially placed into the game in the Play Game Module.  See Appendix B for further explanation.

Piece Status: The piece status indicators show whether or not a piece has moved or engaged in combat in 
the current turn (or, since the flags were last cleared).  These flags appear at various places in the 

Play Game Module, including the Piece Information Window at the bottom left of the main 
screen, and in the Select Pieces for Action window.  An “M” flag indicates the piece has moved. 
An “A” flag indicates the piece participated as an attacker, a “D” indicates it defended (was the 
object of an attack).  In some cases, a “C” is used to indicate it was either an attacker or defender 

(or both).  You can clear/reset,  the flags from the main menu: Game | Advance/Set Turn.  
Piece Values:  These values are set in the Play Game Module, and each piece can have up to 8 specific 

attributes or values assigned.   Piece Values may be changed as the game progresses, and in 
contract to Class Values (see above), often are.  Examples of typical piece values are Supply 

Level, Piece Strength Points, Morale Level, Entrenchment Level, etc.   As with Class Values, 
Piece Values are definable as text (up to 4 characters per value), numbers (0-9999), or yes/no. 
Each of the eight Piece Values can have a unique name of up to 15 characters. It is important to 
understand that all pieces in the gameset will share these Piece Value Names, although the actual 

value for each piece can be different.
Pixels: Pixels are the small single colored dots displayed on your screen.  These dots are used to draw the 

symbols from the Symbol Editor Module. 
PlaceName: A specific name or text string assigned to a Mapboard grid cell.  Placenames are initially 

added to the mapboard, as well as edited in the Mapboard Editor Module.
RAM: Random Access Memory.
Replay: In the Play Game Module, the replay stores, and allows the user to view, all of the game actions 

since the replay was last cleared.  You can see what happened for the previous turn, or for the 

entire game, depending on the settings you choose. You can clear the replay in several ways:  after 
viewing it you have to option to clear it, or from the main menu: Game | Replay | Clear All or 
Game | Advance/Set Turn.

RMB: Right Mouse Button.

Stack: A group of pieces located in the same hex, or undergoing the same action.  Stacks of pieces may be 



represented by a special stack symbol. 
Symbol Sets:  A group of graphic files (*.BMP)  which that contain both Mapboard and Piece Symbols. 

The symbol set file is used by the Mapboard Editor Module to create the Mapboard and by the 

Play Game Module to create classes.   For games with cards, the Play Game Module uses the card 
symbol file to automatically form a deck. 

TEC: Terrain Effects Chart.  It is used in most wargames to define the effects of various terrain types on 
movement and combat.  The TEC can not be incorporated into ADC2 in such as way as to “tell” 

the computer what to do.  In other words, the computer can not automatically count movement 
points, or account for combat modifiers, and things like that.   However, the TEC can be included 
for reference as an InfoSheet in the Play Game Module.

Piece (or Unit) Symbols:  Piece (or unit) symbols are graphic representations of the actual board game 

pieces or cards.  Each symbol must be individually drawn (with the Symbol Editor Module) or 
scanned.  In order for a unit symbol to appear and be used in an ADC2 gameset, the symbol must 
be assigned to a class.  In the case of cards, the symbol must be assigned to a specific deck. The 
same symbol may be used by more than one class or deck of cards. See Appendix B for further 

explanation.
X-Image:  In the Symbol Editor Module, the X-Image option creates an image with transparent (or “see-

through”) areas.   This is a very useful feature, in that it allows symbols to be of any shape, not 
just rectangles.   For example, if you want to make something that looks like a tree, everything 

outside the trunk and canopy would be transparent.  That way, when the tree is placed on the 
mapboard, let’s say on a hex already containing a symbol for grass, the existing grass will appear 
around the tree - in the “see through” areas.  The small box to the right of the “X-Image” text 
identifies the color (on the large image) which represents transparent pixels.  This color may be set 

from the main menu: Preferences | Set Transparent Color, in case you want to actually use the 
currently selected transparent color in the symbol. 

Zoom Levels:  The zoom level represents how “big” the mapboard and pieces appear on the screen.   There 
are three levels, each of which must have its mapboard and piece symbols drawn separately. 

Zoom level 1 should the smallest size hexes (and therefore will display the greatest amount of map 
area at once) while Zoom level 3 should have  the largest hexes (and thus will provide the greatest 
resolution and detail).  

SECTION 4: CREATING A NEW GAME 
The following steps outline the major steps involved in creating a new board or card game.  Click the First 
Time Help button from the Control Panel for additional information.  Remember that ADC2 is actually 
composed of three modules, one of which makes the graphics (Symbol Editor Module), one which creates 

the mapboard (Mapboard Editor Module), and one which is used to actually play the game (Play Game 
Module).  With Windows 95/98, you can run any or all of these modules at the same time (multi-task). 
However, every time you make a change in one module, you will have to reload the gameset in the 
others to see the changes.  For example, if you change a piece symbol in the Symbol Editor Module, that 

change will not appear in the Play Game Module until you reload the gameset (.OPS) file.  Luckily, this is 
easy enough to do by just clicking File from the main menu.  The name of the current game will appear at 
the bottom of the pop-up menu (you should save the current game first, though).

We suggest that users read the entire manual though once before trying to memorize the following steps, or 
even trying to comprehend them in detail.  Because ADC is designed on a set of interrelated components, 
once you understand how these components relate to each other, the details will be much easier to follow. 
Otherwise, new users in particular might find themselves at a loss, since they don’t know how these steps 

“make sense” in view of the overall ADC system.

This section is intended to provide only a general overview of the creation process.  Additional (and very 
specific) step-by-step instructions for common operations are found in Section Eight.



Board Game

Step 1:  Preparation and Testing:  

- Using Windows Explorer, create a new folder in the ADC2 | Gamesets folder and give it an easy 
to identify label, like the name of the game.
- Refer to the physical game and determine if it uses hexes or a square grid.  If it uses hexes, 
determine the orientation (“flat” side up or “point” side up).

-  Decide if you are going to use an existing symbol set, or create a new one from scratch.  In 
almost cases, unless you are an experienced user we recommend creating a new one, since if you 
want to make changes later you won’t have to worry about affecting other games that use the 
symbol set.  Besides, if you want to use all or part of an existing set, you are given that option as 

one of the steps in the creation procedure.  The next few steps are based upon creating a new set 
from scratch.
-  Open the Symbol Editor Module, and create a new symbol set (File | Create New Symbol Set). 
A box will pop up asking to if you would like to copy an existing set.  If you choose to copy, the 

new set will begin as an exact duplicate of the selected set, and the rest of the steps in this and the 
next section are omitted.  Otherwise, from the next window select the appropriate map style (hexes 
or squares) and orientation (vertical = flat side up or hex columns;  horizontal = point side up or 
hex rows).  or vertical hex orientation if you are making a hexgrid map.  If your board game does 

not have hexes or squares (an “area” game, for example), then you can use either.
-  Determine the size of the hexes for each of the three zoom levels.  Remember, the smaller the 
hex or square size, the more mapboard area will be seen on the screen, but the less detail.  If you 
make the hexes/squares too large, only a few of them will be visible on the screen which makes it 

difficult to see enough of the playing area to make decisions.  On the other hand, if you make the 
hexes/squares too small, the playing pieces may not be large enough to include important graphic 
information.  The “best” size is impossible to quantify exactly - it depends on the game as well as 
individual tastes.  So, you’re going to need to experiment! 

If this is your first experience creating an ADC2 gameset, we can’t stress enough how important it is 

to test your sizes after creating one or two symbols before proceeding to make the complete gameset. 

Failure to do so can result in the loss of many hours when you later discover that the mapboard or 

piece symbols are too large or too small.  While the Symbol Editor does include a utility to resize the 

mapboard and unit symbols after you have already created them, the modifications you can make 

using this utility are limited.   And, normally the symbols require "touch-up" work after being 

resized.   Take it from the experts:  even veteran ADC2 users always test before starting to create a 

new gameset.  

To help keep the time you spend making a test set to a minimum, we’ve added instructions (in bold) 

to the end of each of the following sections outlining exactly what needs to be done at that step to 

create a test set.  Once you have completed the necessary work for that step, STOP and proceed to 

the next one.  When you reach the last step, you’ll have a quick set that will be suitable for deciding if 

your sizes a re right.  If they are, you can finish the set in confidence.  If not, return to step 1, and 

continue to make test sets until you’re happy with the results.

Step 2:    Draw Mapboard symbols:  Use the Symbol Editor Module.

-  Create the Mapboard symbols, either from scratch or by copying an existing set and then editing 

as needed.  Remember that you’ll be creating 3 symbols for each board symbol type - one for each 
zoom level. When creating symbols, it is important to take advantage of the power of the differing 
zoom levels.  More detail can be included at the higher zoom levels and unneeded features of 
Mapboard or piece symbols can be omitted from the lower zooms.

-  When you have finished editing a symbol click the Next button.  If you have made changes to 
the symbol, you will be prompted to save it before moving on.
-  When you are done making/editing mapboard symbols, there are two options.  If you are done, 



save and exit.  Otherwise, if you’d like to switch to making/editing piece symbols select Symbols | 
Game Pieces from the main menu. 

From the ADC2 Control Panel, open the Symbol Editor Module by clicking the “Create and Edit 

Symbols” button.  From the main menu, select File | Create New Symbol Set, followed by “Create A 

New Set”.   A form showing  hex orientation and sizes will appear.  Select the appropriate orientation 

(see Step 1) , and whatever sizes you would like to try.  It is a good idea to try and get as wide a range 

as possible, so you can more easily judge which sizes you like better (for example, you may decide the 

size for zoom 2 is good - even if you end up using it for zoom 3!).  We suggest [5-15] for zoom 1, [25-

45] for zoom 2 and [50-75] for zoom 3.  Notice the symbol representations at the bottom change size 

to match the values entered.   They show exactly how big each hex (or square) will appear on the 

screen.  But, it can be deceiving - the sizes often “seem” different once you’re looking at a lot of hexes 

together on a mapboard.   Click OK.

On the window which pops up, click “Map/Board Symbols”.   A new window will pop up from which 

you can edit and create symbols.  Leave the default “Blank” symbol as is, and click on the “Create 

New” button.  Enter the symbol name as “Grid”.   The window will disappear, leaving you at the 

main editor.  Click on the X-Image Box.  Under Preferences (main menu), select Set Transparent 

Color.  Click on one of the eight colored boxes and click OK.  Your X-Image symbol "Grid" will 

automatically change to the color you just selected.  This color will not be visible when this symbol is 

displayed on the mapboard - it is transparent or “see through”.  

If you are using hexes, click on the small hex button above the X-Image box.  This will automatically 

add a black outline around the edge of the hex symbol.  Do this for each zoom level (use the Zoom + 

and Zoom - buttons to move between the zoom levels).  If, instead of hexes you are using squares, you 

will have outline the square manually.  Use the line (or pencil) mode to draw a line in the outermost 

pixel around the edge of the symbol.    Note that color of the border is the “primary” color (shown in 

the left color box).  If you would like the border to be another color, left click the mouse over the 

color grid (and the color box will change).    Save the symbol by clicking “Save” and proceed to Step 

3.

Step 3:  Draw the piece symbols:   Use the Symbol Editor Module. (New Piece)

-  Piece symbols are drawn just like the mapboard symbols, except each one may be of different 
size  (up to 120 x 120 pixels), including sizes larger than the mapboard hexes/squares.  Sizes for 

each piece symbol are set when the symbol is created.  They can not be changed later (other than 
by using the  resize utility, which has limited flexibility).

Select Symbols | Game Pieces from the main menu.  Click the “Create New” button.  When you 

create your first piece the first thing you are confronted with is determining the size of the piece. 

Name the first piece “Test 1”, and leave the symbol sizes alone.  Click OK and change the color of 

each zoom level symbol.  To do this, left click on a color you like from the palette (the left color box 

will change), then click on the bucket (Fill Region Button).  Move the mouse to the left (edit) window 

and click anywhere on the symbol, which will fill it with the color.  Repeat for each zoom level, and 

click “Next” (Yes to Save!).  Create another new symbol.  This time, increase the size of each symbol 

by about 50% and name the symbol “Test 2”.  Click OK, and begin editing the symbol.  Follow the 

same fill procedure used for “Test 1” with “Test 2”, excepet make sure to fill it with a color different 

than you used for “Test 1”.  Save the symbol.  At this point, if you like you can make one or two more 

symbols of different sizes, or add actual graphics and numbers to the symbols.  Just remember not to 

spend too much time on it, since the goal of this process is only to confirm the sizing of the symbols. 

When you are satisfied, from the main menu select  File | Save Symbol Set.  Name the set  something 

like “Test Set”, so it won’t get confused later with a “real” set.   Close the Symbol Editor Module.

Step 4:  Draw the board game map:  Use the Mapboard Editor Module.

-  The size of the mapboard (in hexes) is set when the mapboard is initially created.  The size can 



be adjusted later as needed (both + and -) in the Play Game Module.
-  Mapboards are composed of individual hexes, each of which contains one or more symbols 
(created in step 2).  In wargames, these hex features are usually known as “terrain”.  The hex 

symbols must be entered individually for each hex, although there are fill routines to add large 
areas of similar types easily.
-  The Mapboard Editor Module also contains routines for adding hexlines, hexsides, placenames, 
mapsheets, and everything else required to create a game board or map.  These features are 

covered in more detail below.

Open the Mapboard Editor Module (click the Create and Edit Maps/Boards button from the Control 

Panel).  From the main menu, select File | Create New Mapboard.  Click the “Select Symbol Set” 

button and locate your gameset folder (from Step 1).  Open the symbol set you created in Steps 2 and 

3.  Adjust the map size as required.  We suggest that you make the mapboard size 4 hexes larger in 

each direction than the actual mapboard to create a border.  For now, don't worry about making the 

mapboard large enough for any off-map tracks or information - the mapsheet can easily be enlarged 

by using the Play Game Module "Advanced"  function.  Click OK and you will be presented with a 

Zoom Level 1 view of your map.  From the main menu, immediately select File|Save Mapboard As 

and enter the name of the game.  Then select Preferences | Select Mapboard Overlay and select the 

symbol named "Grid" (which you made in Step 2) and click OK.   You should now see the grid on 

the mapboard.   Save the mapboard (click the button with a picture of a floppy disk) and close the 

Map Editor Module.

All of the remaining steps are performed in the Play Game Module.  Details on each step are provided in 

the section on the Play Game Module, and are not include here.  Be sure to save your work frequently.

Step 5: Create a New Game

Select "File|New Game"  You will be prompted to name the gameset (name it “Test”)  and select a 

Mapboard.  Select the mapboard you just saved in Step 4.  Read the help file which appears.

Step 6:  Create Players

You can skip this when creating a test set.

Step 7:  Set the Facing style if needed.

You can skip this when creating a test set.

Step 6:  Create Classes (excluding playing cards-see below)

Select "New|Class."  Your first Unit Symbol "Test 1" will appear under #2 Pick Symbol.  The Class 

Name defaults to the Symbol name.  Leave it and click Save.  Read and accept the Help Window.  In 

#2 Pick Symbol, use the window list to select your Symbol "Test 2" and save.  Do this for all the test 

symbols you made.  Quit when you have made classes using all the symbols you made.

 Step 7:  Create Pieces:

Select 'New|Pieces."  You will see a list of all the classes you just created.  Select one by clicking on it 

- it will be highlighted by a blue bar when you do.  Click "Add to List," and then "Place Now." The 

Create New Pieces window disappears and you can see your map.  You can zoom in and scroll 

around.  When you click on the map, a piece will appear of the class you selected.  Multiple clicks on 

the map will create more pieces.  When you have placed a few pieces, click "Okay" in the toolbar and 

the Create New Pieces window reappears.  Select another class and place a few pieces on the map. 

Click "Okay" each time you are done placing pieces to return to the window.  When you have made 

and placed pieces for all the classes you made in Step 6, exit out of the window.



Check all the pieces at various zoom levels to see which best suits the terrain symbol and overall 

mapboard size you have created.  Note which symbol looks best.  You can go back into the Symbol 

Editor and make more test symbols of different sizes if you need to experiment more.  If none fit 

properly in the hexes, you will need to change the size of the terrain hexes/squares.  It is best just to 

start over at this point, but since you've only created a small test set, you have not lost much. 

However, if you have a good match, save the game and exit the Play Game Module.  Open the 

Symbol Editor and delete the Unit Symbols you do not want to use, and then Optimize the symbol 

set.  Now you can begin creating unit and terrain symbols "for real" using the symbols you have as a 

base.  While you can immediately see how the terrain symbols will look by opening the Mapboard 

Editor and reloading the symbol set.  In order to check out how your unit symbols look, you'll have 

open the Play Game Module.  Reload the Test.ops file and create classes and pieces as needed to 

check out how your unit symbols look when in the game.  You are not going to want to use the 

test.ops file for a real gameset module, so don't feel compelled to make classes and pieces for all 

symbols.  When the mapboard is complete and all unit symbols are done, delete the Test.ops file and 

create a new gameset including players, facing, pools, class and piece data and all the other 

information required to make a fully playable gameset.

  
Step 8:  Begin the game.  Read Sections Seven and Eight for more information.

Card Game
Note:  ADC2 comes with two standard card deck symbol files (with and without Jokers).  Skip to step 3 if 
you would like to use these.  As with boardgames, it is important to test your card symbol sizes before 
getting too far into the set creation.

Step 1:  Preparation:  Refer to the actual card game.
- Determine how many card faces you need.

Step 2: Draw the card symbols:  Use the Symbol Editor Map (New Piece)
- Create a new symbol set.  Note: For Boardgames with Cards, you must create a new symbol 

set that is named differently than the piece/unit symbol set.  Note that a gameset can have 

multiple card symbol sets, unlike the unit symbols.  In fact, if you have a boardgame with 

cards in which each player has his own set of cards and there is no card play between players, 

it may be advantageous to make a symbol set for each player's cards.  This will make card 

deck and hand creation easier.

- Try 75 x 100 as the size for zoom level 2.  ADC2 maximum card and unit symbol size is 120 x 
120 pixels.  You can ignore the hex/square size if you are making a card symbol set for a 
boardgame.

- Draw the back of the card as the first piece symbol.  ADC2 automatically uses the first card 
symbol as the back of all cards in that set.
- Save the file.

Step 3:  Draw the playing surface symbols:  Use the Symbol Editor Module (New Board/Map Symbol)

- If you just want a green tabletop, make symbols that are all green - and a table border symbol.
- If you are adding cards to a boardgame gameset, make no mapboard symbols.
- Save the file separately from the card file.

Step 4:  Draw the playing surface:  Use the Mapboard Editor Module.

-Skip this if you are adding cards to a boardgame gameset.
Step 5:  Begin the game:  Use the Play Game Module.

-Follow the procedures for starting a new game listed above.
-If you are adding cards to a boardgame gameset, open the ops file for that gameset.  You will add 

the cards to your gameset ops file.
Step 6:  Create the Deck:

- Select Cards | Decks | Add a New Deck and select the card symbol set you just created.
-Select the options in the Add New Cards to the Deck form.  Change the name of the Deck if you 

want.  If you select "Custom" you will be given the opportunity to create different numbers of 
cards as each card symbol is displayed.  Select the option to place the cards face up or face down.
-You can create multiple decks from the same card symbol set.  Be sure to give each deck a 



different name to avoid confusion.
- Select Done.

Step 7:  Create the Hands:  

-Select "Cards|Hand|Add a New Hand" from the Menu Bar.
-Name the Hand and the Player.  This information is important when there are multiple hands in a 
game.  You can create as many hands as needed.
-Select Done.

Step 8:  Card Play
-Select "Cards|Decks" and double click on the deck you want to open.  The Deck window which 
opens allows you to perform a number of different functions which are fairly self-explanatory. 

Click on Deal and select the hands (or hands) you want to deal cards to at the bottom of the form. 
Click on the ALL radio button and then the Deal Now button.  Exit.
-Now select Cards | Hand and double click on the hand you want to look at.  If you made the 
cards visible to yourself when you created the deck, you will see them listed on the left along with 

the various other card play functions on the right.  Click on a card to highlight it and then select 
"Play Card."  The mapboard is displayed.  Click somewhere on the map and the card you selected 
will appear and the Hand Form will reappear - minimize or exit from it.  Depending on the 
visibility option you selected when you created the deck, the card will either be face-up or face-

down.  Place the mouse cursor over the upper left-hand corner of the card and click.  You will be 
presented with several options for now.  Try flipping the card first.  Click in the upper left-hand 
corner to perform another function like returning the card to the hand or the deck.

These topics are covered in greater detail later in the manual.

NOTE:  Once cards have been added to a game set, you can no longer edit them using the Symbol 
Editor.  If you need to make changes, you will need to remove the cards completely from the 

game, and recreate them from scratch once the changes have been made.  Use Cards|Remove 
Hands and Decks.  Then edit the original card symbol set using the Symbol Editor Module. 
When you have made the necessary changes, start the game fresh (in the Play Game Module) and 
create the new decks and hands as needed.



SECTION 5: THE SYMBOL EDITOR MODULE

The Symbol Editor Menu Bar

File    Symbols    Edit    Image Regions    Preferences    System Utilities   Help 

File Menu

The FILE menu has the following choices:

  Open Symbol Set - to open up an already-created symbol set.
Create New Symbol Set - to create a new Symbol Set, either from scratch or by coping from an existing 

file.   The disadvantage of copying is that the zooms are already defined.  The advantage is the old 
symbol set may possibly contain most of what you already want, so a new set can be created with 

very little new effort.

Create New Symbol Set first takes you to a screen where you select:

Map Style: either Real Hexes, Grid, or Hex (ADC1 Format).  This will depend on your playing 
surface.  For a typical wargame with hexes, the Real Hex option would be the best choice.  There 
are two types of Real Hex Orientation, either Vertical or Horizontal.  The bottom of the screen 
depicts the actual hex appearance, so you can evaluate your choice before saving.  For the typical 



boardgame, the Grid style would be best.  Selecting Hex (ADC1 Format) will show hexes, but the 
actual shape of the grid will be off-set squares, as in ADC1.

Hex Size:  The display size of a single hex (in pixels) is adjustable for each zoom level.  The total 
hexes per screen (at 640 x 480 resolution) is displayed next to the pixel size for reference.  Note that 
even though ADC2 uses the term “hex” to denote a single area on the Mapboard, it applies to 
“squares” as well.

The general rule of thumb is that at Zoom Level 1, you should be able to see the entire Mapboard. 
At Zoom Level 2, a typical piece’s one turn movement path should be contained within the 
displayed hexes without having to scroll.  Zoom Level 3 is usually set at double or triple Zoom 

Level 2 for detailed views of pieces and combats.  Obviously, the larger the hexes, the less of them 
will fit on your screen at one time.  On the other hand, the larger the hexes, the more detailed the 
Mapboard and pieces can be.  What sizes you pick will depend on the scale of the game, the typical 
movement distances of pieces (in hexes) and personal taste. 

Save Symbol Set - to save a set to the already-named file.
Save Symbol Set As… - to save a symbol set file to a new file name.
Remove Symbol Set - to delete a symbol set you no longer need.

Exit - to return to the ADC2 Control Panel.

Symbols Menu

The Symbols menu contains three entries, which are only accessible once you have opened a symbol set (or 
are starting a new symbol set). 

Mapboard Symbol - to start editing the Mapboard symbols of a set. 

Piece Symbol - to start editing the piece symbols of a set.  These represent the playing pieces, or cards of 
the game. 

Resize Utility - allows you to change the size of the symbols of a complete zoom level.  For example, if 
you made zoom level 1 too small by accident, you can use this option to increase or decrease the size of all 

piece and Mapboard symbols by a multiple.   One limitation is that real hex symbol sets must be resized in 
a multiple of five, i.e., if zoom two is currently 25 pixels across, you can’t resize it by half, as that would 
result in a hex size of 12.5 pixels.   Use of this option is recommended for advanced users.

Selecting one of the first two entries brings up the Symbol List screen.  From this you select:
Create New - to create a new symbol. If it is a piece, you are allowed to adjust the size.  You can 

use different size pieces in the same symbol set.  Both pieces and Mapboard symbols must be 
named. 

Copy - to create a new symbol by copying from an existing symbol.  This is extremely useful if 
you need to make pieces that are identical except for their color, or are similar but need minor 
changes.

Move Symbol Up (Down) - to move symbols either up or down on the master list, allowing for a 

more logical grouping.  This is handy if you’ve forgotten to make one symbol and you want it 
to show up next to all the other similar symbols.  DO NOT MOVE SYMBOLS IF A 
MAPBOARD OR GAME HAS ALREADY BEEN CREATED!  You may endanger those 
files.

Open - to edit the highlighted symbol on the list. Alternately, simply double-click on any symbol 
on the master list and it will open.

Rename - to rename the highlighted symbol to whatever new name you desire.
Remove - to delete a symbol from the list.  Once deleted, it cannot be undone.  DO NOT 

REMOVE A SYMBOL IF A MAP OR GAME HAS ALREADY BEEN CREATED.   You 
may endanger the map file.

Exit - to return to the editing screen.



A Sample Mapboard Symbol List

Edit Menu

For both Mapboard and Piece symbols, there are two selections:
Flip Image Left to Right

Flip Image Top to Bottom

Only the symbol shown on the screen will be flipped.  You must repeat the flip for each zoom level.
Scale Copy Zoom 3 to 2

Scale Copy Zoom 2 to 1

These make it possible to "auto-size" higher zoom level symbols to the lower zoom  levels.  This feature 
can really speed up creating a symbol set by eliminating the need to recreate each zoom level symbol from 
scratch.  Create your Zoom 3 symbol first and then , select "Edit | Scale Copy Zoom 3 to 2" from the main 
menu.  The zoom level 2 symbol will be created automatically from the existing zoom 3 symbol. Then 

select "Edit | Scale Copy Zoom 2 to 1" from the main menu.  This will create the zoom level 1 symbol. 
Note that it works best for mapboard terrain symbols. The new symbols may often still need some minor 
editing. Using this function for Unit Symbol creation may or may not have the desired effect dependent on 
the symbol you are making.

Image Regions Menu

The Image Regions command is a powerful feature of ADC2 which allows you select an image region 

(.bmp file) and paste it into your symbol.  

The menu choices are:
Import Image Region - to open a .bmp file for use in the current Mapboard or piece symbol.  After you 

select the .bmp file, it is saved to the clipboard and you can place the cursor (normally in the upper 
left corner) onto the Mapboard or piece symbol.  Click and the image will be placed onto the 
symbol.

Export Image Region As… - to save a selected area to a new filename.

Note:   ADC2 defaults to a “standard” 256 colors to save space and time.  However, ADC2 can actually 
use 16 million colors.  We have included a file called hps.pal which is our “standard” 256 color palette. 
Use of the “standard” palette keeps the file sizes very small.  When creating a gameset, you can scan in the 

pieces and then convert them to the standard HPS palette in order to save memory and file size (or, even 
better, set your scanner to use the hps.pal palette and scan them in using the standard palette).  However, if 
you are not concerned with file size (especially if it’s a small game) then feel free to directly import .bmp 
graphics without converting them.  The only disadvantage to this is an increase in the size of the .bmp files 

representing the pieces.  They do compress quite nicely, but a big game will be several megabytes in size.



Preferences Menu

This menu controls the overall functioning of the symbol editor. 

Turn Grid ON/OFF - to toggle which turns the square grid on or off.  The grid is there in order to assist 
you, but is not visible when actually playing with ADC2.  The grid is defaulted to ON.

Airbrush Settings - to adjust the size of the airbrush, and how much “paint” is sprayed, by adjusting the 
size and the flow control respectively.  The maximum value is 10, the default is 5.

Turn Auto Expand ON/OFF - to automatically expand zoom level 1’s image to the next two zoom levels. 
You must completely draw the symbol in Zoom 1, then it will automatically be expanded to the 

other two zooms.  If you edit in zoom 1 after the expansion, the edits will not appear in the other 
levels.  The auto-expand applies only to piece symbols, it has no effect when drawing Mapboard 
symbols.

Set Transparent Color - to change your transparent (background) color to a different color.  This new 

color is saved in the file gamename.XET.  You must still select X-Image to implement the 
transparent color.

System Utilities Menu

Resize Symbols – This command allows you to completely resize all of the symbols.
Optimize Symbol Set - to reduce the file size of symbol sets and eliminate dead space caused by deleting 
symbols.  It is essential to Optimize your symbol sets after deleting symbols or creating over 200 symbols. 

Failure to so may cause serious problems in creating additional symbols or playing the game.
           Rebuild Transparent Symbols – Sometimes transparent symbols will get out of order and you will notice 

problems with your transparent symbols having large areas of black on them or parts of other symbols on 
them.  They may also no longer be transparent when viewed.  If you have a symbol set that has a large 

number of transparent symbols (X-Image) it highly recommended that you perform this function 
frequently.  First back up your gameset in case there are problems in the process.  The rebuild function is a 
resource intensive process and requires ample free memory.  If your system has other programs running 
and the symbol set is large, the rebuild program may halt.  After backing up the gameset, Optimize it and 

then proceed with the rebuild.
Reset Symbol Order - During the course of symbol editing, you are allowed to move symbols up and 
down on the master list in order to more logically group them.  This menu item merely resets all symbols to 
their original order.

Remove Terrain Symbols – If you wish to use a gameset as the base for a new game, wanting to keep the 
unit symbols but you don’t want the terrain, this command will delete all the terrain symbols at once.  DO 
NOT remove terrain symbols after you have started making a map.
Remove Game Pieces - If you wish to use a gameset as the base for a new game, wanting to keep the 

terrain symbols but you don’t want the old game pieces, this command will delete all the game piece 
symbols at once. DO  NOT remove game piece symbols after you have started making an .ops file in the 
Play Game Module.

Help Menu

The Help menu has three choices:
Help Index - This brings you to the help menu based on topics. The Help menu is a hypertext-driven 

system that is standard to Windows applications.
Complete Manual -  Brings up this manual for printing or reading on screen.
About Symbol Editor - This gives you the current version number of the editor and other general 

information.

Symbol Editor Buttons and Screen

The symbol editor has a series of  buttons which control the current editing procedure.  Once a symbol set 



is loaded, and a symbol has been opened for editing, you will see it displayed in the large box on the left of 
the screen.   

The right half of the screen contains the palette at the top, below which are:

Active Primary and Secondary colors -  located below the palette colors.  To change them, move the 
mouse anywhere on the palette, and left-click to change the primary, right-click to change the 

secondary.  Alternately, use the Grab Color function listed below.  
Color Number Box:  Next to the primary and secondary colors is the color number box. When you have 

loaded a color that is NOT one of the standard 256 colors, the box will show “---.“  
Custom button. ADC2 has the ability to go beyond the standard 256 color palette.  Such custom colored 

symbols require a larger file, and therefore create larger gamesets.  You can create and store up to 16 
custom colors at a time via the Custom Color screen.  However, you can access and use in your 
drawing any number (or even ALL!) of the 16.7 million colors available in the Windows palette.

The edit command buttons are on the right - center of the screen.

Set Draw Mode - to place individual pixels.  Click on the symbol location to change that pixel to the 
current primary color.  

Set Line Draw Mode - to draw a line.  Position the cursor, click and drag the endpoint to the desired 
location and release.

Filled Rectangle - to draw a rectangle. Position the cursor, left click and drag the opposite corner.  The 
rectangle will outline in the primary color, and fill with the secondary color.  For best results, always 

create your rectangle from left to right.
Filled Ellipse - to draw an ellipse. Position the cursor, left click and drag the opposite corner.  The ellipse 

will outline in the primary color, and fill with the secondary color. For best results, always create 
your ellipse from left to right.

AirBrush - to “spray paint” the symbol area with the current primary color.  The size and flow are 
controlled via the Preferences menu, with defaults set at 5 and 5.  This feature is useful for creating 
woods and rough Mapboard, etc.

Fill Region - This fills an enclosed region with the current primary color.  The area must be fully enclosed 

by pixels of the selected color, or the entire screen will get filled instead. 
Paste Image - to paste an area captured by Select Region.  The last region selected will be pasted.
Switch Color - to switch any color on the symbol with the current primary color.  This is a very useful 

feature you will use often. For example, when making a chess game, you only need to draw the 

pieces once.  To make the pieces for the other side, you’ll just copy the originals and change their 
color.  For example, you’d copy the white pawn symbol to use as the base of the black pawn, make 
the primary color black, then click on Switch Color.  Next, click on any white pixel on the symbol. 
All of the white pixels will change to black, and your black pawn is finished!

Grab Color - to select the primary color from a symbol, instead of from the palette. For example, say you 
want to be sure that Zoom 3 pale green is the same as Zoom 2 pale green.  You can select the 
primary color by clicking on Grab Color, then by clicking on Zoom 2 pale green.   The primary color 
will now be the exact same pale green.  

Draw Mapboard Outline - to place an hex outline around your Mapboard symbols (as is the case with 
most maps) with the current primary color.  Hint:  In ADC2 only one symbol in the set should be 
given a outline (unlike in ADC1).  This symbol can then later be designated as the grid overlay 
symbol for the map - enabling it to be toggled on and off.  If you outline each symbol, the grid will 

be drawn whenever the symbol is drawn and thus can not be toggled.  To make a grid overlay 
symbol, create a new symbol and simply click this outline button with the X-Image turned on.  If 
you like, you can also add other features (tick marks, center dots, etc.) that will become part of the 
grid display.

Add Text - to add text to the symbol.  Please note that at lower zoom levels,  there may not be enough 
pixels to properly display text.  You have the option to change the font, color, and characteristics of 
the text.

Clear to Secondary Color - to fill the displayed symbol with the current secondary color.  This feature is 

useful for restarting your current effort from scratch.



Select Region - to select a rectangular region from the symbol edit screen and duplicate it.  Drag and click 
the area you want to copy, then move the mouse to the upper left corner of the desired region to be 
changed.  This can be used to copy an area between zoom levels.  You can also select a region and 

open a new symbol set, enabling you to copy parts of or entire symbols between sets.
Undo Last Action - to delete your last editing action.  It only undoes the LAST action you took.
X-Image (Transparent Image) - to select that designated color will represent “transparent” areas of the 

symbol.  When selected,  pixels of this color become “see-through”.  The color that represents 

transparent areas can be changed selected from the Set Transparent Color under Preferences 
Menu.   In ADC1, transparent symbols were used for  “secondary terrain”, and they still serve that 
function well.  For example, you could make a national capital by drawing a red star on a gray 
background, and selecting gray as the X-Image color.  The result would be that only the red star 

would appear on the map - the gray will be transparent.  Both Mapboard and piece symbols can be 
transparent.  The included chess set shows some good examples of using transparent piece symbols.

Below the edit buttons is a view of the image at the size it will appear on the map. At the bottom of the 

screen are information boxes.  These tell you what grid cell you are pointed to, the Mode, or type of editing 
you have selected, the Zoom Level, and the symbol name.  In the far right corner are the Zoom level 
buttons, and the Save button.  The Zoom + and Zoom -  buttons are used to move between zoom levels for 
the selected symbol.  After editing the symbol, click the Save button.

SECTION 6: THE MAPBOARD EDITOR MODULE

The Mapboard Editor Menu Bar 

File    Mapboard Symbols    PlaceNames    HexLines    HexSides    Elevations   MapSheets 



Preferences    Help 

File Menu

The Mapboard Editor File Menu has five options.  They are:

Open - to open an existing .map file.

Create New Map - to start a new/board map by creating a .map file.  First you must chose the symbol set 
that the Mapboard will use.  You will also be asked to establish the size of the Mapboard.  If you are 
creating a multi-mapsheet game, make this size large enough to accommodate ALL the maps as they 
are assembled, plus any margins you want. In other words, if you have a game that contains 4 maps, 

arranged in a rectangle, and each map is 30 x 60 hexes, then your Create New Map size should be 
at least 60 x 120.   

Use Scanned Map - ADC2 allows you to utilize any bitmap (.bmp) as the board for your game. 

Examples would be a topographic map that has been scanned in and saved to a .bmp format, or a 
board you’ve drawn in an advanced Paint program.  Mapboards which are based on a bitmap or 
scanned in map act exactly like ordinary maps/boards in all ways - you can still create and place 
Mapboard symbols on them, draw hexlines and placenames on them, assign mapsheets for them, and 

play games on them.

One word of caution is that this option is generally practical only for small bitmaps, due to the large 
size of the .bmp files.  Of course, much of that is dependent on the resolution of the scan (100 dpi or 

less is recommended as a starting point) and whether the scan is in color or not.  Some trial and error 
will be required in order to determine the best size for the hexes as well.   

When used, the program automatically “sizes” the bitmap image for all three levels; you need only 

create or scan the Mapboard as a .bmp file then convert it with the scanned-map program.

NOTE:  There appears to be a limit on .bmp file size when running in Windows 95/98.   This limit 
seems to be about 4 million pixels, with a maximum of 1700 pixels per side.   Bitmaps larger than 

this may not load properly.   This limit applies to all bitmap files, including terrain, pieces, and 
scanned in maps.   To help get around this limitation, a multiple scanned-in map option was added.

Save Mapboard - to save the current .map file to the same name.

Save Mapboard As - to save the current .map file to a different name.   
Exit - to return to the Control Panel.

Mapboard Symbols Menu

The Mapboard menu item has 3 submenus.  They are:

Place Primary Mapboard - to select and place the Mapboard symbol as a Primary Symbol.  

Place Secondary Mapboard - to select and place the Mapboard symbol as a Secondary Symbol. 
Secondary symbols are “overlaid” on top of Primary Symbols. For example, Secondary Symbols of 
factory, port, capital city, etc. are placed on top of Primary Symbols of clear, grassland, sand/shore, 
woods, etc.  Secondary Symbols must created with X-Image so as to be partially transparent or all 

they do is hide the Primary Symbol.

After selecting the Primary or Secondary Symbol, click repeatedly on the Mapboard to place the 
symbol. Symbol names appear in the lower right of the screen as you move the mouse over them. 

You can quickly change from placing Primary and Secondary Symbols without using the pull-down 
menu by simply clicking the radio button on the floating form.
 

Fill Primary Mapboard - to fill an area with the selected symbol.  First, you must enclose an area with a 

primary symbol.  Then select Fill and click anywhere inside the bordered region.  The area will 



convert to the same Mapboard type.  Examples of use are for creating the border around the 
mapboard, large wooded or ocean areas.

PlaceNames Menu

Click on Place Names | Add/Modify Place Names  then click onto the desired hex location on the map. 
The Add Location Screen then pops up.  You can select the Font, Orientation (placement within the to the 

hex), Color, Style, Symbol (Placed as Secondary), Size for each Zoom Level, and the text.

Note: If Preferences | Fast Scroll is ON, you will not see the Placenames on Zoom level 1.

HexLines Menu

Hexlines are lines which connect the center of hexes to the center of other hexes. The most common use of 
hexlines are roads, railroads, and other features which normally are in the hex, and not on the edge of a hex.

Before placing HexLines, you must define and select it.  Click New to save your Line Definition Name, 
Line Color, Draw Priority, Line Style, and Line Size for each Zoom Level.  The new name then appears in 
the list below Definitions.  Pick Save to save your changes.  Click Done to return to the map, and begin 

placing the HexLines.  Then, click on the starting hex for the line origination.  You will see a small, hollow 
square which tells you which hex has been selected for connecting to (this is the “hot hex” indicator). Then 
click a neighboring hex to draw the line.  

Hexlines can be drawn with a priority setting. When several lines are in the same hex, the highest priority 
setting (10 being the highest) hexline is drawn on top of all the others.  The default hexline setting is “---“ 
which means no priority.

Note:  If line size is set to zero for any zoom level, then the hexline will not appear, but it is still there.  

The Hex Lines Screen

HexSides Menu

 
Hex sides are lines which are drawn on the edges of hexes, as opposed to in the center.  The most common 
usage of hexlines is for rivers, streams, political boundaries, and other Mapboard features which tend to be 

on the edges of hexes.

There are two methods to add HexSides.  The easiest allows you to click directly on the Mapboard, as long 
as your hexes are at least 10 pixels in size.  To enable this method, go to Preferences from the menu bar 



and check that: Add HexSide Mode is Map (if not, click on it). Then, select HexSides | Add/Modify 
HexSides and choose the line style to add.  When using this method, you will need to put the mouse over or 
slightly to the right of the actual hexside - clicking in the center of a hex will have no effect.

The other method will take you to a form window, which contains the outline of the hex.  To use this 
method, first set the HexSide mode to form by selecting Add HexSide Mode is Form from the 
Preferences menu.  Then  select HexSides | Add/Modify HexSides and then click on the map hex.  The 

HexSides window will pop-up.  You must first select Add Hex Side  to select the line style (the same line 
stypes defined in the HexLines screen). Select Done to return to the HexSides window, and click on the 
side to draw the line (N, S, E, W, etc.).  As with HexLines, multiple lines can be drawn for each side.  Click 
Save for each hexside added, and Done to leave this window.  

The HexSide Form Window

Elevation Menu

ADC2 now has hex elevation routines which are intended for use with games that require Line of Sight 

calculations.    If the game you are making/playing does not have LOS considerations, you may ignore all 
of these options.    

Set/Modify Hex Elevation –  With a map loaded, you can set the elevation of any given hex to the desired 

integer.   After setting the elevation, click on each hex you wish to change.
Fill Map Board Elevation – This option allows you to fill the entire map with the desired elevation. 
Normally, you would use this option first when assigning elevations to a map, by using the elevation that is 
most prevalent on your map.  (IE, if 75% of the terrain on your map is elevation 10, then fill the map with 

elevation 10, then change the other elevations later.   75% of your work is now done).  To use this option, 
set the elevation to the desired number, then click on any hex on the map.
Map Elevation Display is: OFF/ON – This option displays the current assigned elevation number for each 
hex on the map.   You will need to toggle this option to ON when setting elevations to be able to see what 

each hex’s current elevation is.    Normally, this option should be toggled to OFF during play.

MapSheets Menu

MapSheets enable ADC2 to display hex numbers that correspond to the board game.  If the board game 
does not use a numbering scheme for locations, mapsheets are not necessary.

For Single MapSheets

Adding a mapsheet is not just for games with a multiple maps.  You must also use it for single map games 
to name the map and number the hexes.  For a single map, Select Add/Modify Mapsheets from the 
MapSheet menu, then enter the MapSheet Name and the Hex Numbering - Height and Width (as a 
minimum) and Save.  The MapSheet name will then appear at the bottom of the screen in the information 



box.

For Multiple MapSheets
From the Mapsheets screen, you will divide the overall map into numerous mapsheets (no practical limit). 
You create the mapsheets, name them, then adjust the Hex Numbering and Style parameters to make the 
hex numbers work out right. Use the View/Edit Position button to confirm the location of the mapsheet on 

the overall map. 

Preferences Menu

Select Map Overlay Symbol - to pick the grid outline symbol you created with the Symbol Editor.
Fast Scroll is On (Off) - to toggle between a fast scroll and a normal scroll speed.  When Fast Scroll is On, 

the PlaceNames, HexSides and HexLines will not appear on Zoom Level 1.
Place Names are On (Off) - to toggle between showing place names or not.  If the text on the Mapboard is 

distracting you or getting in the way, you can toggle the display to Off.  The name will still appear at 
the bottom left of the screen.

Save Map Position is Off (On) - to toggle the Save Map Position Feature.  When turned On, the map 
“remembers” where it was if you leave the map display, and will return to the last zoom level and 

same place as when you left it.  When turned off, the Mapboard display always returns to the 
upperleft corner at zoom level 1.

Set Table Color - The table color is the color of the unused portion of the Mapboard display (i.e., that 
portion of the screen not covered with hexes or squares).  

Set Hot Hex Color - When drawing HexLines and HexSides,  the selected hex has a blinking square 
placed in the center of it, so you know which hex you are changing.  This “hot hex” color is 
adjustable for better visibility.

Add HexSide Mode is Form/Map  - to set the method of adding HexSides to either Form (to use the 

HexSide Form window) or Map (to add HexSides directly by clicking on the Mapboard hexes).

Help Menu

The Help menu item brings you to four submenu options:  

Map Information - This item is grayed out unless a Mapboard is currently loaded into the mapbuilder.  If 
clicked, it gives overall summary information about the Mapboard currently being edited.

Help Index - This activates the standard indexed help file, which is similar to the manual, but with indexed 
topics added.

Complete Manual - This pulls up the entire manual online, which can be read or printed out.
About ADC2 Map Builder - Gives the current version number and other information about the program 

itself.

Map Editor Buttons

Below the menu bar are buttons.
Open File  - to open an existing file.

Save File - to save to the current file name.
Zoom In - to go to the next higher zoom level.  Click on the area you want to see at the next zoom level.
Zoom Out - to go to the next lower zoom level.
Re-Draw - to re-draw the screen.

Mapboard Editor Screen

Next to the buttons, an information box shows the current Zoom Level.  Below the button bar is the 
Mapboard.  Below  and to the right of the map.board is the information box.  This lists the Mapboard name 

and hex number, and all of the symbols in that hex.  At the very bottom of the screen is the current status.  



To get specific information about any hex, right click and the Hex Info window will appear, listing all the 
features of the hex.

Hex sides and hex lines can be removed from this screen.  Also, notice that ADC2 displays hex features in 
the box in the order they are shown.   So, the last or “top” feature drawn is the one at the bottom.   You can 
clear ALL terrain features by clicking on Clear Hex, or you can clear (delete) individual hex sides, lines, or 
secondary terrain.

SECTION 7: THE PLAY GAME MODULE

This is the Play Game Module main screen which you will seeing while playing a gameset.  The Toolbar 
and Buttons across the top control the various program and game functions.  The Mapboard Screen displays 



the map area shown as determined by the Zoom Level selected.  Scroll the map by using the slider bars or 
using the keypad arrow keys (be sure NUM LOCK is on).  Below the map is the Piece Data Box and the 
Terrain Data Box.  Both show relevant information as the mouse cursor passes over different pieces and 

hexes on the mapboard.  These boxes can be sized by dragging the horizontal bar on top of the data boxes 
and the vertical bar between the two.  Below the data boxes is an information bar that shows the current 
player, the name of the gameset .ops file, and the turn.

Once a gameset has been created and saved, there are no specific requirements for actions to be performed 
in any order.  You can setup and move pieces, roll the dice, flip pieces and cards or remove them from the 
mapboard  (and many other functions) in any order as required by the rules.  Play the game on the computer 
as you would play the actual game on the table.

Clicking on the Mapboard

There are several functions you can perform by clicking on the Mapboard.

From the Normal Mode (as noted at the bottom of the Play Game screen), a left click on a hex without 
pieces will bring the Select Pieces for Action window with only the Add Pieces button visible at the 
bottom.  Clicking this button will take you to the Add Pieces to the Game screen - the same as selecting 
New | Pieces  or  clicking the Construct button and picking  Pieces.

Clicking on a hex with pieces will bring up the Select Pieces for Action  window with all of the pieces 
listed, and seven buttons at the bottom.  From this window, you can edit Piece information, Move, select 
pieces to Attack or Defend, Add additional pieces to the hex, Remove pieces or Flip a piece.  Readjust the 

column sizes if not all information is visible.

There are several columns for each piece row:  the first column  (no heading) indicates that the piece is 
currently selected for action.  The Facing column (which only appears if at least one class in the game is 

assigned a facing style) indicates the direction of the selected facing for the piece.  The Piece ID lists the 
name of the piece, the Class Type shows the class name for the piece, the M/C column will indicate if the 
piece has already moved  “M” or been in combat “A” (Attack) “D” (Defend )or “C”.  The Piece Values 
column lists the actual entries for each defined Piece Value, the Class Values column lists the actual 

entries for each defined Class Value, and the Player column indicates the owning player.  Each entry can 
be edited by highlighting the piece row, and double clicking on the entry.

To move the selected piece(s), click the Move Piece button.  You will return to the Mapboard, where a [X] 

will indicate the current piece location.  Clicking on additional hexes will show [1], [2], etc. to indicate the 
piece’s planned movement path.  During movement, you can click the Undo button to go back a move. 
When finished, click the OK  button on the main button bar, or the Right Mouse Button to complete the 
move.



To attack or defend with the selected piece(s), click the Attack With or Defend With button.  An [A1]  or 
[D1] will be shown on the map screen at the piece’s location.  The number after “A” or “D” represents the 
number of pieces in the hex which were selected.  So, for example [A3] indicates 3 pieces in that hex were 

selected to attack.  When all of the attackers and defenders have been assigned, click OK from the main 
button bar.

To remove the selected piece(s) from the board, click the Remove Pieces button.  The pieces can be moved 

to either the Force Pool, or completely from the game.

To flip the selected piece(s), click Flip Pieces button.  If a flip definition has not been set for this class, you 
will be given the opportunity to do so.  Flip definitions can also be set from the Edit | Flip Definitions 

menu.

To select all pieces on the list, click the All button.

To re-arrange the order of the pieces in this hex, click the Sort button in the upper left hand corner.  The 
sort will also apply to the order in which piece symbols are drawn on the map. Click OK when finished.

These functions will be described in greater detail in following sections.

The Play Game Menu Bar

Once a file has been loaded, the menu bar options are:
File  Edit  New  Facing  Replay  GameInfo  Pages  Printouts  Advanced  Cards  Preferences  Help 

File Menu

New Game - to start a new game.  First you must enter the filename for the new game, then you select a 
map to use.

Open - to open an existing file.
Save - to save the current game to the same file name.
Save As - to save the current game to a different file name. 
Exit - to exit to the Control Panel.

Filenames - The last 5 files opened are listed here - click to load.

Edit Menu

Players -The various hidden piece and detection range routines depend on the Player set-ups.  

This screen has four main areas:  

Player Name/Picture -  First, the Player’s name and graphic can be edited.  Each player may have a 
bitmap picture (.bmp) file displayed on the log-in screen.  You can choose the picture from the 
list of files which are included with ADC2, or any valid .bmp file.  The size of the bitmap is not 
critical, as the program will resize it to fit the screen area.  If you pick a custom bitmap for a 

Player definition, just make sure to send it to all the other human player (in an email game). 
Search/Reveal Range -  This characteristic is important only if at least one enemy player is using 

hidden pieces.  This range is the number of hexes that this player’s pieces can detect hidden 
enemy pieces.

Password Protection - to choose a password.  Passwords prevent anyone else from logging-in under 
your player name.  Passwords are optional.

Hidden Piece Options - This part of the screen controls if and how hidden pieces will be used.  If 
Hidden Pieces is checked, you will be able to check the other boxes as appropriate.  If desired, 

a default symbol (a Piece symbol created in the Symbol Editor Module) can be set for this 
player.  When set, this symbol will be displayed to enemy players where the hidden piece is 



located.   Basically, this allows for two types of hidden systems.  In the first type, without a 
hidden piece symbol, pieces are truly hidden, and no symbol at all is drawn on the map until the 
piece is found (and its normal symbol drawn).   The second system, using a default hidden piece 

symbol, creates a “partially hidden” situation.  Enemy players see the “dummy” symbol on the 
board, but they don’t know what kind of piece it actually represents.  

Classes - to edit an existing Piece Class.  Players can change a Class’ Values, Name, Symbol, Facing, 
Hidden Symbol, and Owning Player.   Note:  Piece classes must be created for each different type of 
piece which will be present in the game.  For example, in checkers at least two classes must be 
created: Red Checker and Black Checker.  At that point you could also create classes for the Red 

King and Black King, or, otherwise set the first checker piece value as a “King” (Yes or No).

For wargames, think of a piece class as the equivalent to a unique type of cardboard counter.   If a 
game contains both a 6-6 US Infantry piece, and a 5-6 US Infantry piece, then you would want to 

create two different piece classes, one for each cardboard type of counter.  This is true even though 
they are both infantry pieces.   Similarly, pieces of a different nationality need to have unique piece 
classes.   Therefore, for example, to represent a French 6-6 Infantry, and a US 6-6 Infantry, you 
would need two piece classes.  

Once a class has been created, it can be used to create as many pieces as desired.  Thus, if a chess 
game has 8 white pawns, one class would be sufficient to replicate them all.  The general rule of 
thumb is that if the game’s markers or cardboard counters look significantly different, they each 

need a separate piece class.   Identical (duplicate) counters all belong to the same piece class, and 
only one class is needed for any number of identical looking counters.

FOR FURTHER EXPLANATION OF PIECES and CLASSES, SEE APPENDIX B.



Class Name - The name can be up to 28 characters and/or numbers.
Display Symbol - choose the symbol (from those created with the Symbol Editor Module) you 

wish to represent this type of piece.
Facing Style - you may indicate whether or not facing is to be used in conjunction with this piece. 

Before this can be activated, the Facing Style type must be defined from the Facing menu.
Owning Player - if a piece is associated with only one side, you can pick which player it belongs to 

from the list.   Otherwise, you can select All Players.
Hidden Symbol - to pick a hidden piece symbol for this class.   The class must have a valid Owning 

Player.  When selected, this symbol will “override” the default player hidden symbol for pieces 
of this class.  If the Hidden Option was not checked from the Player Information screen, the 

hidden symbol can not be selected.
Values - Each class can have up to 8 definable values associated with it.  Values are not required. 

One thing to keep in mind is that values entered in the class definition should apply equally to 
all pieces created from that class.  For example, the 7-8-12 class below has the first value named 

as “Attack” with a value of 7, the second value named “Defense” set to 8, and the third named 
“Movement” and set to 12.  

Class values should never be set to characteristics that will vary between pieces of that type.  For 

example, in checkers you would not want to set a class value to “King”, since it would cause all 
of the checker pieces be either Kings or not.  Instead the “King” value should be assigned to the 
pieces themselves.

All of the classes defined for a game will share the same value names and types, although the 
values themselves can be different.  So, once value 1 is set to “Attack”, it will be “Attack” for 
all of the game’s classes.  Generally, class values should not be changed during the game.  

Pools - to create, edit, or use force pools.   Think of  Force Pools as off-board holding areas, designed to 
reduce screen clutter.  Pools are often used for administrative things such as a “dead pile”  or 

reinforcements. 

The Force Pool Screen is divided into four columns.  On the left hand side is the Enter Name / 
Select Pool column, listing of all the force pools that have been created for the game.  Click on any 

force pool to select and highlight it.

The second column, Select Pieces for Action, shows all the pieces that are in the highlighted force 
pool.  Clicking on any piece places it into the third column, and enables it to undergo various 

actions.

The third column, List Selected for Action, is the action list.  These pieces can be placed on the 
map, deleted, or edited.



The fourth column of the screen is the Force Pool command list.  These buttons are short cuts to 
using Force Pools.

Place Now - Places all pieces currently in the List Selected for Action column onto the map.
Done/Cancel - Exits the Force Pool Screen.

Pool Options:
Delete Pool - Deletes the highlighted force pool.  Use with caution!
Make New Pool - Creates a new force pool.  You will be prompted to enter a name for the pool.
Add New Pieces - This allows you to add new pieces to the currently selected force pool.

Select Options:
Select All - This option selects ALL the pieces in the currently highlighted force pool and places 

them into the List Selected for Action column.  This is useful for placing a large amount of 

pieces on the map at one time.
Random Pick - Another new feature, this allows you to choose ONE piece randomly out of the 

currently highlighted force pool.  This is extremely helpful for games that contain “unknown 
strength” pieces which are determined by chit draw.

List Options:
Clear List - to remove all the pieces in the List Selected for Action by returning them to the force 

pools they started from (without deleting the pieces).

Delete Pieces - to permanently delete from the game all the highlighted pieces in the List Selected 
for Action column.

Transfer Pieces - to transfer the pieces in the List Selected For Action to another pool.   First, 
place the pieces you wish to transfer into List Selected for Action column.  Click on Transfer 

Pieces.  At this point, the pieces are grayed out.  Then go to the Select Pool column and click 
on the destination force pool to complete the transfer.

Edit Piece Info - to edit the Piece Values.  From the Edit Piece Value window, you can cycle 
through each piece listed on the List Selected for Action column.  



Flip Definitions - to define a piece class to be the “flip” side of a different piece class.   Before you can use 
the Flip option from the Piece screen, a flip must be defined for the piece class.   ADC2 also allows 
you to automatically create a reciprocal flip (in other words, if your game has weakened units that 

are allowed to flip back to full strength.   If you check the box at the bottom of the form, the flip 
definition will be created both ways automatically between two symbols.)

Stack Symbols - to assign a special symbol to represent a  stack of pieces.  The special stack symbol is 
created from the Symbol Editor.  Stack Symbols defines the conditions for displaying the stack 
symbol.   Players can set the number of pieces required to be “included” in a stack at each zoom 

level and a Required Piece.   

Concerning the number of pieces setting, it is the number of “undrawn” pieces in the hex, and thus 
whether a stack will be drawn or not will also depend on the number of symbols drawn per hex 

setting.  For example, if you have four pieces in a hex and the draw pieces per hex is set to 4, a stack 
symbol will never be drawn - since all 4 pieces will be drawn normally.  However, if the number of 
pieces to draw is 1, and the number of pieces setting is 3 or less, the stack symbol will be drawn.   

If the Required Piece is set, at least one of these type of pieces must be present in the group of pieces 
to be drawn as a stack.  If the required piece is not set, the stack will be “generic”, in that it will be 
drawn as a default any time none of the other stack symbols apply.   

As an example (shown below), this player has created an infantry stack symbol (in the Symbol 
Editor Module), and has set it to be displayed whenever a infantry piece is present in a hex with at 
least 2 other pieces that are not individually drawn.



The Stack Definition Screen

New Menu

The New Menu has four sub-menu items. See Edit Menu section for additional information.

Player - to define a new player for a particular game.  

Class - to create a new Class 
Pieces - to place a new piece on the board using the Add New Pieces to the Game window.  Note:  Pieces 

must be created from existing classes.  If you have not defined an appropriate class for the pieces 
you wish to create, you will need to go back and do that before continuing. 

First, select the Class for the new piece(s).  Next, select a quantity desired (default value is 1) then 
click on Add to List.  In this way, you can place an entire stack of pieces or add them one at a time. 
Notice that ALL of the pieces in the List to be Place box will be placed in the same hex on the map 

as soon as you click on Place Now.  You can continue to click on the Mapboard to continue placing 
the exact same number and type of pieces onto the map.  Click the OK button when finished.

Another way to place pieces on the board is to click on the map location.  The window Select Pieces For 
Action will pop-up, which has a button at the bottom to add pieces.

FOR FURTHER EXPLANATION OF PIECES and CLASSES, SEE APPENDIX B.



Pool - This brings the player to the Edit Force Pool Screen. (See above Edit Menu)

Facing Menu

This menu command takes you directly to the Piece Facing Options window, where you define the game’s 
facing styles.  To use facing for a piece (once you have defined an appropriate facing style), set the piece’s 
Class facing style from the Piece Class window, then set the facing direction from the Piece Information 

window.  Normally, you want to define facing styles before creating classes.  That way you can select the 
facing style at the same time you set all of the other information for the new class.

Replay Menu

The Replay menu item has two sub-menu choices:  

Show All - to show the recorded actions taken, such as combat, dice rolls, and comments.  There are two 

options - the Delay Amount and Start Point, to control the speed of the replay, and the starting 
action of the replay.

Clear Replay - to erase the current replay.  Normally, this should be done at the beginning of each turn 

after the second player has seen the replay.  However, if desired you can continually build the replay 
throughout the game by never clearing it.  For long games, however, the replay files can get very 
large and increase file transfer times.

IMPORTANT NOTE:  The  UNDO list is maintained in the replay file.  When you clear the replay, 
it will no longer be possible to UNDO actions before that point.

Game Menu

Next Turn/Set Turn - to advance or set the turn number, and name the turn (Optional).  Also, you can set 
the options to clear the turn settings of  movement flags, combat flags, and saved replay actions.

Edit Turn Names - to edit the names of turns (optional).

Mapboard Display Options:

Symbols per Hex - to display the first four pieces in a hex.  Any other pieces are stacked 
“underneath” them and are not visible.  This method works well if you make the piece symbols 
about ¼ of the size of the overall hex, thereby allowing all 4 symbols to be fully displayed.

Notice you can set the display options differently (1 vs. 4 units) for each zoom level.
Grid Display - toggles a hex outline symbol on and off.  The hex outline symbol (drawn in the 
Symbol Editor Module) is a transparent symbol with only the border outlined in a solid color.   The 
grid symbol is set for the Mapboard in the Mapboard Editor Module.  This option provides an easy 

way to toggle the grid overlay pattern on and off over the entire Mapboard.
Show Hexlines – This toggles the hexlines to on or off.
Show Hexsides – This toggles the display of hexsides on or off.
Show Placenames – This toggles the display of the names (text) on the map on or off.



Show Pieces – This toggles the actual units on or off.  This is handy if the units are obscuring the 
terrain underneath and you need to see if a river hexside exists, etc.
Put Class on top in Hexes – This allows you to designate a certain unit class  (type of unit) that you 

wish to be always displayed as the “top” unit in a stack in a hex.
Piece Status Dots – This option allows you to “flag” units which have (or have not) performed 
certain functions during a turn.   For example, in really large games, you might forget who has 
moved, or attacked , etc.   Although there is already a method to tell if a unit has moved or not (if it 

has moved, the M letter is no longer grayed out when you click on the unit) this is just one more 
visual aid to help you in playing games, especially the larger ones.   Status dots can also be used to 
visually flag pieces which have values above or below a certain value.  For example, units with less 
than 100 men, or no ammo, etc.  Using status dots you can see these units at a glance, rather than 

having to go “dig” for the information.

As you can see from the above picture, the status dots can be assigned to represent a variety of 
functions, and you can edit their location on the unit and edit their color and size.   The use of status 
dots is totally optional and can be ignored if desired.

Sound On - Enables sound effects.
Sound Off - Disables sound effects.
Fast Draw On - to speed up the drawing of Zoom Level 1 Mapboards by not drawing the PlaceNames, 

Pieces,  HexSides and HexLines.  Zoom Levels 2 and 3 are unaffected.  Normally, this option will 

NOT be needed, except for very large Mapboards.
Fast Draw Off - to disable the Fast Draw option.
Auto-Save - to save the game every “X” minutes, where you determine what X is.  The default setting, if 

enabled, is every 5 minutes.

Combat: Set Summary Values - to set the class and pieces shown in the combat summary during the 
replay.  Normally, if a game has combat strengths, only combat strengths should be checked.  If it 
has attack/defense strengths, then you would want both of those checked.  The summary only aids 
players in resolving combats, it does not actually calculate odds.

Set Scroll Jump Size - to set how far the screen jumps (in hexes) during scrolling action.
Log-in as Another Player - to log-in as another player, without exiting the current game.
Right Mouse Button - to set the function of the right mouse button.  If set to “normal” you have all of 

these options, which will appear in a pop-up menu.  Otherwise, clicking the RTB will go directly to 

an option, saving one click.  The options for the RMB are:
-Move All pieces (in the hex, as a group)
-Place pieces
-Zoom in/out

-Redraw Map
-Single LOS check



-Area LOS check

The LOS options will not be available unless you have defined elevations for the various Mapboard 

hex types, and have set Advanced | Use Elevations on.
Additionally, there is another option called “Flip All Pieces” which will show up if you have the 
RMB set to “normal”.   This option flips all the units in a hex to their flip defined side.

Info-Pages Menu

Info-Pages allow you to include text and/or pictures as part of  your gameset.  For example, you can 
scan in the combat results table from the game, or you could make a running diary of your game’s 

progress.   You can define a maximum of 10 Info-Pages.   If you use a bitmap picture file (.bmp), 
use the mouse to “drag” the edges of the box until it fits the picture image.  The program will save 
the size of the new box for displaying the image in the future.

Printouts Menu

This menu item has five sub-items:

This Screen -  to print the map area inside the current screen.  (not the menu and buttons)
Entire Game Board (complete) - to print the entire map at the current Zoom Level.  Note: the success of 

this operation will depend on your computer’s available resources.  For very large printouts, your 
system may run out of resources - at which point Windows95/98 should abort the operation. Note 

that you can also direct the screen shot to be saved as a .bmp file by checking the "Print to File" box 
on the standard Windows "Print Job Setup" window.

Pieces - to print a complete list of pieces or a partial list of pieces based on criteria you specify.
Classes - to print a complete list of piece classes of the currently loaded gameset.

Total Pieces On-Board – Prints a complete list of all game pieces currently on the map.   You can adjust 
the list to include only those that have numerical values (and therefore not print “informational” markers) 
and you can view units in pools as well.   This option is very handy just for viewing, besides printing. 

Advanced Menu

This menu item has thirteen submenu choices. 

Import Class Data (From Database) (Advanced Users Only)- This option is for advanced users, who 
wish to import (from a database) class information for many piece classes all at the same time.

 In order to use this advanced option, you must input the data for the piece classes into a database 

with either fixed field lengths (listed below) or with the use of a delimiter.  
Fixed-length fields must be padded with zeros to the left if the value itself does not take up the 
required number of places.   For example, a value of 32 exported to a fixed-length of five would be 
saved as “00032.”   When using a delimiting character (the default is a comma), padding is never 

required since the program knows the entire value has been read when it hits the delimiter.  In the 
above example, the value would be saved as “32,”.  
A hard return must be placed at the end of each line in the file, for both fixed-filed and delimited 
types.  

ADC2 reads in the following values, in order.  You will need to insure that your database saves the 
fields in the same order (and to the correct fixed-field length, if not a delimited file)

Value                                       Acceptable Range of Values                             [Fixed length(if used)]  

Class Name [25]

Symbol number    0-2999 ( piece symbol numbering starts at 0)[5]   



**** Individual Class Values and Types (repeat 8 times for each of the 8 values) ****

  Value Type         0=not used, 1=numeric, [1]
2=alpha, 3=Yes/No

  Value 00000 (if not used) [5]

00032 (example numeric)
0ABCD (example alpha)
00001 (if Yes)
00000 (if No) 

**********************************************************************

Owning Player 200=All Players [3]

201=No Players
0=first defined player
1=second player, etc.

Hidden Symbol 00000-29999 defined symbol [5]
30000=Player default symbol
30001=No hidden symbol

Facing Style 000=None [3]
001-249 Defined facing style,
in order starting with 1.

[HARD RETURN]

This option is useful primarily for extremely large games with hundreds, if not thousands, of piece 

classes.

Import Class/Unit Data (from Other Game) – This allows you to import unit data from an existing 
ADC2 gameset for use in a new gameset.   This is primarily intended for use with games that have 

different maps but a very similar set of units.
Resize Board / Playing Area – This option allows you to trim or add extra rows or columns to your 

playing map.  This has been added here instead of to the Mapboard editor so that you can change the 
map even after a game is underway.  Click on the appropriate buttons to add or trim rows or 

columns.  The utility will automatically save your existing map by appending “(Backup)” to its file 
name.  If the changes aren’t what you wanted, you can go back to the original by just deleting the 
“new” map file  (mapname.map) and then deleting the “(Backup)” from the backup file name.  For 
example, if your original file name was GAME.MAP, after you change the size you will have two 

map files in your folder:  GAME(BACKUP).MAP  and GAME.MAP.   The first is the original, the 
second is the new resized map.   The game will always load the one called GAME.MAP.
One thing to be aware of is that pieces and cards on the board areas to be trimmed are simply 
deleted.   There is no warning message, they are just removed from the game.

To maintain hex grain patterns, you can only trim or add in increments of two hexes.  In addition 
you can only trim down to a minimum of 5x5 hexes, and cannot add hexes to exceed 60,000 hexes.

Run Range/Auto-Reveal Now - to have all on-board pieces search for hidden enemy units in their search 
range. Be sure to run this function after making any changes to any Hidden Unit status in the Player 

Information edit window.
Run LOS Auto-Reveal Now – this runs the autoreveal function except that the range is also limited by 

those units that are within the Line of Sight of the spotting unit.
Run Auto-Reveal When Moving - to have moving units automatically search for hidden enemy units each 

time you select a new hex for them to move to.



The Auto-Reveal routine detects hidden pieces based on the Search/Reveal  Range set as a part of 
the Player Information.  In a very large game, you may want to have Auto-Reveal When Moving 

turned off, and click Run Auto-Reveal Now at the end of your movement in order to save time. 
However, you run the risk of a moving piece “accidentally” moving onto or through a hidden enemy 
piece.  For smaller games,  the Auto-Reveal When Moving  should remain on, and enemy pieces 
will be revealed as you select each hex in the movement path.  Once revealed, pieces remain known 

until the auto-reveal is manually run by clicking Run Auto-Revel Now.
Auto-Reveal During Combat ON(OFF) – This new addition allows you to have units become revealed 

when chosen for combat.   Other pieces in the same hex but not chosen for combat are NOT 
revealed.  All pieces in a defending hex are revealed, however. Following all combats, be sure to run 

Run Range/Auto-Reveal Now rehide all units.
Use Elevations - This option can be checked as on or off.  If ON, the elevation of each hex will be 

displayed in the lower right hand information box.  The elevations for each Mapboard Symbol are 
defined using LOS: Set Mapboard Values.

LOS: Set Mapboard Values - to assign the Base Elevation, and Other Terrain Properties to a 
Mapboard symbol.  

Above Ground Level (AGL)  is the elevation of a feature above the ground level of a hex.  The 

ground level of a hex is always equal to the Base Elevation of its’ Primary Terrain.  If there are 
Secondary Terrain types in the hex, they (and their Base Elevation) are ignored in determining the 
ground level.  However, should  the secondary types contain features with heights above ground 
level, these features will extend normally above the hex’s ground level.  In addition to the Base 

Elevation, the Primary Terrain may also have an AGL (for example, to represent trees rising above 
the base elevation). 

AGL Display Color is the color used for the AGL terrain in the single LOS results display.  That 

way you can graphically see the terrain and AGL features.  Typically, shades of green are used for 
foliage (trees, woods, etc), gray or black for cities, etc.  In the display, ground level is always drawn 
as brown.

Blocking Points are a degradation of the sighting range.  The number of points required to totally 
block sighting is adjustable from the LOS: Characteristics window.  Whenever an LOS is 
determined to pass though this terrain feature, this number of blocking points will be added to the 
running total. 

% When Spotting Location is the percentage of normal LOS blocking points that will be added to 
the running total if this terrain type is in the spotting hex.  Normally, this will be a value close to 
50%, assuming the spotter is in the center of the hex.

% When Target Location is the percentage of normal LOS blocking points that will be added to 
the running total if this terrain type is in the target hex.  Normally this will be a value close to 50%, 
assuming the target is in the center of the hex.



LOS: Set Characteristics - to set the LOS general values.  A new feature here allows you to add a hex 
size, with an integer and a unit of measure.   For example, you might want to make the range 
measure “100”  and “meters”.   This is used when the LOS is reported.

Check Line of Sight (LOS) - to check LOS between two points or an area.  

Set Player Alliances – Alliances are now able to be set between players.  This is essentially meaningless 
unless a game is using hidden pieces.   Basically, pieces belonging to allied players are treated as one 

force for spotting  purposes.   Allied pieces always see each other.   A special use of the alliance 
feature is to distinguish between pieces belonging to a single player, but that have different 
search/reveal ranges.   For example, one player could be called “United States”  and another player 
called “US Air Force”.  You could ally the two players, but the USAF search range might be 10 



hexes and the United States search range 3 hexes.   Because allied players have all their pieces 
known to them, you don’t need to log in as both players…you only need to log in as either player 
and move all the US pieces in this example game.

Cards Menu

Decks -   To use a deck in a game, you must first add cards to it.  Then you can Open the deck and Shuffle, 

Deal, Put the Top Card on the board, Sort, Rename the Deck, Delete, Pick Up All Cards, and 

Add Cards.

Hands - After creating the card deck, then create each card hand.  Return to the Deck window to deal the 

cards, then come back to the Hands window to play.  Clicking the Play Card button will place the 
card on the board. Cards are actually pieces displayed on a map hex.  Therefore, if you place several 
cards on the map in the same place, they are displayed in the order they have been played. 

Follow these basic steps to play cards:

Step 1:  Load the deck.  From the Card menu, select Decks.  From the Card Decks window, select  Add 
New Deck and click on the deck filename.  A pop-up window Add Cards to the New Deck will 

build the deck.  Click OK when finished, and Done from the Card Decks window.

Step 2.  Select Hands from the Cards menu, and click Add New Hand.  Add a hand for each player. 
Click OK then Done to return to the Play Game screen.



Step 3.  Begin the game.  Return to the Cards | Decks  window and double click on the deck name to open. 
The Deck window will pop-up.  You may deal the cards from here.

Step 4.  Return to the Cards | Hands  window to play your hand.

Preferences Menu

There are ten options under Preferences:

Ask: Place From Pools - If this option is checked, you will be prompted whenever you try to place a new 
piece on the map and asked if you wish to place a piece from a force pool.  This is useful for games 
will lots of reinforcements or pieces that you have chosen to place into a pool.  If this option is not 

checked, pieces will be created from scratch when they are placed.
Ask: Remove To Pools - If this option is checked, you will be asked whenever you remove a piece from 

the map if you wish to place the piece into a force pool.  This is useful for games where it is 
important to keep track of “dead” pieces, for example.  If this option is not checked, removed pieces 

will be permanently deleted from the game.
Autoplace Pieces From Pool - If this option is checked, placing a new piece on the map automatically 

takes you to the Force Pool screen.
Autoremove Pieces To Pool - If this option is checked, removing a piece from the map automatically takes 

you to the Force Pool screen.



Sort Class Alphabetically - when lists of classes are displayed in the various ADC2 forms, they will be 
sorted alphanumerically.  Otherwise, classes will be shown in the order in which they were created.

Combat: Roll Dice Automatically - to automatically bring up the roll dice screen after choosing the 

attacking and defending pieces and clicking OK from the Menu Bar.
Default Comment to Text – The comments box has options for a video, sound, etc.   However, normally 

the text box is used 99% of the time.   This option when toggled on automatically brings you to the 
text comment form instead of one of the other types.

Set Form Background Color - to set the background color of the ADC2 pop-up windows.
File Directories/Folders - to set the default paths where ADC2 will look for files.  Changing these paths 

only alters the ADC2 default list, it does not actually rename or create subdirectories themselves.
Resizable Forms – This allows you to resize some of the forms (pop-up windows) to whatever size you 

find convenient.  They will stay resized for the remainder of the current playing session.   With some 
computers this may cause lockup problems; if that occurs, leave this option off.  The forms that can be 
resized are:
Edit Force Pools

Remove From Board Options
Edit Flip Defs
Generic List Form
Get Piece Class

Get Piece from Pool
Get Pieces to Place
Combat Summary (Pieces)
LOS X-section

Select Pieces for Action

Help Menu

Help Index - to search by topic.
Complete Manual- to display the entire help manual.
About - ADC2 version information.

Play Game Buttons

Load a New Game - to open a previously created gameset from file.

Save This Game - to save the current game to a file.

Zoom In - to magnify the map to the next higher zoom level.  If already at zoom level 3, this 
button will be grayed out (not available).

Zoom Out - to view the map to the next lower zoom level.  If already at zoom level 1, this button 
will be grayed out (not available).

Redraw the Map - to redraw the map display. Use this when the screen does not display all 
hexlines, hexsides, or splits the screen irregularly after scrolling or zooming.



Roll the Dice - to roll the dice and add comments.   Die rolls become part of the replay.

Add a Comment to the Replay - to add comments to the replay. 

Cycle through pieces - to cycle through all or some of the on-board pieces; very handy in large 
games w here it’s easy to lose track of who’s been moved.  When cycling three other buttons, 

Next, Previous, Stop  will appear at the top of the screen.

Next/Previous/Stop -  to quit or move to the next or last piece during cycling.  Each 
click will bring you to another game piece on the map.  The Stop button ends the 

cycling routine.

Undo - to delete your last action.  

Construct - to edit or create players, classes, pieces and Force Pools.

Find - to find and scroll to a particular hex location or piece on the map.

OK  - to complete an action (move or combat).  When highlighted, click this to exit the action.

SECTION 8:  STEP BY STEP INSTRUCTIONS

Symbol Editor 

Creating Mapboard Symbols

Symbol Editor Module
1.  Select Create New Symbol Set  from the File menu to draw a new set.

2.  Set the Map Style, and Hex Size from the pop-up window and click OK.
3.  Select Mapboard from the Edit menu.
4.  Select Create New from the Symbol list.  

- Recommend creating a “grid overlay” symbol as part of the Mapboard set.

- The first symbol on the list will be used to fill new Mapboards.
5.  Enter a name for the new symbol.
6.  Draw all three zoom levels. 
7.  Save by clicking the Save button at the bottom right of the screen.



Editing Mapboard Symbols

Symbol Editor Module
1.  Select Open Symbol Set from the File menu to edit an existing set.
2.  Select a symbol set to edit.
3.  Select Mapboard from the Edit menu.

4.  From the symbol list, click on the symbol name.
5.  Edit the symbol.
6.  Save by clicking the Save button at the bottom right of the screen.

Creating Piece Symbols

Symbol Editor Module
1.  Select Create New Symbol Set  from the File menu to draw a new set.
2.  Set the Map Style, and Hex Size from the pop-up window and click OK.

3.  Select Piece from the Edit menu.
4.  Select Create New from the Symbol list.
5.  Enter a name for the new symbol.
6.  Set the piece size for each zoom level.

7.  Draw all three zoom levels.
8.  Save by clicking the Save button at the bottom right of the screen.

Scanning Mapboard and Piece Symbols

Scan the piece and save it as a .BMP file.
Symbol Editor Module
1.  Select Pieces from the Edit menu.
2.  Select Import Image Regions from the Image Regions menu.

3.  Select the BMP file.
     Or

Multi-task leaving both the Symbol Editor and you own paint or image-editing program open.  When 
in the paint program, select the image or area of an image and copy it to the clipboard. Switch back to 

the ADC2 Symbol edit and select Image Regions|Import Clipboard.

Editing Piece Symbols

Symbol Editor Module

1.  Select Open Symbol Set from the File menu to edit an existing set.
2.  Select a symbol set to edit.
3.  Select Piece from the Edit menu.
4.  From the symbol list, click on the symbol name.

5.  Edit the symbol.
6.  Save by clicking the Save button at the bottom right of the screen.

Creating Grid Overlays

Symbol Editor Module
1.  Create a new Mapboard symbol to use as the grid overlay.
2.  Check X-Image.
3.  Set the primary drawing color to the desired grid line display color.

4.  Click the Draw Terrain Hex Side Lines button.
5.  Do not outline any of the other Mapboard symbols in the set.

 

Creating Card Symbols

Symbol Editor Module
1.  Select Create New Symbol Set  from the File menu to draw a new set.
2.  The Map Style and Hex Size settings are not important, so just click OK.

3.  Select Piece from the Edit menu.  (Do not make Mapboard symbols.)



4.  Select Create New from the Symbol list.
5.  Enter a name for the new symbol.
6.  Set the piece size for each zoom level.

7.  Draw all three zoom levels for the back of the card symbol.  This symbol must be first on the symbol 
list.  (Consider making all zoom sizes the same, as this will reduce the amount of work required in 
creating the set.  You can easily select the zoom 1 image and copy to zoom 2 and 3)

8.  Draw all three zoom levels for the front of each card in the deck.  (You can make the front and the back 

of the cards different sizes.  It is recommended you make all the card symbol sizes the same)
9.  Save by clicking the Save button at the bottom right of the screen.

Editing Card Symbols

Symbol Editor Module
1.  Select Open Symbol Set from the File menu to edit an existing set.
2.  Select the card symbol set to edit.

3.  Select Piece from the Edit menu.
4.  From the symbol list, click on the card name.
5.  Edit the card symbol. The card back symbol must be first on the symbol list.
6.  Save by clicking the Save button at the bottom right of the screen.

Mapboard Editor Actions

Editing Mapboards

Map Editor Module

Requirement:  The symbol set file must already exist, although it may be in a draft form.
1.  Select Open from the File Menu, or click the Open button.
2.  Chose a map file (mapfilename.map).
3.  Edit the map.  You cannot change the map size.

4.  Save the map by clicking the Save button, or by selecting Save from the File menu.

Creating Mapboards

Map Editor Module

1.  Select Create New Map from the File Menu
2.  From the Create a New Map Window, click Select a Symbol Set, and select a file containing the 

symbol set for your Mapboard (symbolfilename.set).
3.  Select the orientation for the map grid cells (hexes).

4.  Enter the Map size in grid cells (hexes).  If your game has multiple map sheets, enter the overall size 
when assembled.  It’s a good idea to add a few extra rows and columns to make a border (or in case 
you miscalculated the total size).

5.  Click Select a Map Overlay Symbol from the Preferences menu. This step is not required, however if 

you do not have a map overlay symbol, it may be difficult to tell which hex you are pointed to unless 
each Mapboard symbol includes a grid outline.

6.  Click on MapSheets.  This step is not required, however it is where the map hex numbers are assigned.
7.  Click Place Primary Mapboard symbols  from the Mapboard Symbols menu.  Then, place the 

symbols on the map by clicking on the grid location.
8.  Click Place Secondary Mapboard Symbols from the Mapboard Symbols menu.  Then, place the 

secondary types over the primary symbols.
9.  Add PlaceNames, HexLines, and HexSides as needed to complete the Mapboard.

10.  Save the map by clicking the Save button, or by selecting Save from the File menu.

Scanning Maps

Scan in the map using a scanner and the software that came with it and save the image as a .BMP file. 

Consider scanning the map at a lower resolution (75 or 100) to decrease the file size, as the BMP size is 
limited (see Note below).  You can also paint your own map using a paint program or use BMP images 
from digital maps available on internet or in commercial map programs.



If you scan a map using a 8.5 x 11 flatbed scanner it is recommended you scan the map in sections and 
assemble them into a single map bmp file. This can be challenging process, as it is difficult to get each 

section aligned so they match the other sections exactly.  Use an image-editing program to rotate or make 
minor changes in size to the images as needed to fit them together, and use various paint tools which are 
usually included in the software which comes with the scanner  to smooth the transitions between the 
sections.

Map Editor Module
1.  Select Create a new map from the File menu.
2.  Click the Scan Map button.

3.  Click the Change button to select the saved .BMP file as the Bitmap To Use For the Board.
4.  Select the zoom level for the .BMP file.  At this zoom level the file will be displayed at exactly the same 

size as it is stored.  Be warned, if you have a large base bitmap file and select it to be used at Zoom 1, 
ADC2 will need to create even larger files for Zoom 2 and Zoom 3 - which may exhaust your system 

resources and cause the operation to fail.  It is recommended to use your base BMP file as the Zoom 3 
image and let the scanmap program reduce it to create the zoom 1 and 2 maps.

5.  Select the hex sizes (in pixels) for each zoom level.  Based on your selection in step #4, ADC2 will 
automatically scale your saved file up or down in proportion to the selected hex sizes.

6.  Select the hex style and orientation. 
7.  Select Continue.  ADC2 will automatically scale the bitmaps and create a symbol set to the 

specifications you entered, which may be edited normally in the Symbol Editor Module.

Note: The maximum single bitmap size allowed is limited to 4,176,000 pixels and 2730 pixels in either the 
X or Y axis.  If you have a map in which the scanned BMP file is larger than this limit, one option is to 
decrease the size of the BMP file using the software that came with your scanner. Another option you 
can use the "Multiple Base Mapsheets" in the scanned-in map routine.  To use this, first cut the 

original BMP file into separate BMP files that the system can handle.  Again you must use a separate 
image editing or paint program. Be sure to name the individual BMP files of your map with names that 
indicate their position in the map as a whole.  The "Multiple Base Mapsheets" option configures the 
scanmap program to piece these smaller chunks of your map into one map in Map Editor and Play 

Game Modules.

To use this option, follow the procedure to create a normal scanned-in map.  On the scanned-in map 
options form make sure the box next to "Use Multiple Base Mapsheets" is checked.  This box is 

located under the box and button to select a single mapsheet.  Make sure all of the hex size and 
orientation values are set properly, and click "Continue".  The next form allows you to:

    *Select individual BMP files to use as base mapsheets
*Add additional BMP files to the map and position them to fit the base mapsheet.

    *Set the X and Y (in pixels) value for the upper left corner of each BMP.
    *Set the total map size, in hexes.

You can also change the position of the map sections in the Map Editor Module using the Mapsheets | 

Adjust Base Maps option.  This allows you to immediately see the result of your adjustments.  Remember 
you changing the mapsheet upper left corner X and Y values.

Scanning Mapboard and Piece Symbols

Scan the piece and save it as a .BMP file.
Symbol Editor Module
1.  Select Pieces from the Edit menu.
2.  Select Import Image Regions from the Image Regions menu.

3.  Select the BMP file.
     Or
Multi-task leaving both the Symbol Editor and you own paint or image-editing program open.  When in the 
paint program, select the image or area of an image and copy it to the clipboard. Switch back to the ADC2 

Symbol edit and select Image Regions|Import Clipboard.



Adding/Removing HexSides/HexLines (Roads, Rivers, Railroads, etc.)

Map Editor Module
From the Map Editor screen with a map already opened, determine whether the road/river/railroad/etc. will 

connect to the center of the hexes or run around the edge of the hex.

For lines that run between hexes, select HexLines.
1. Select a line style from the list, or create a new line style from the Hex Line menu.  For example, a thick 

blue solid line may represent a river, and a black thin line may represent a small road.  Click Done 
when finished.  

2. Click the first hex you want to connect.  A highlight symbol will appear.
3. Click on an adjacent hex.  The line will be drawn between the center of the two hexes.

For edge lines (HexSides): 

There are two methods to draw hexsides.  Pick the method from the Preferences menu as either Add 
HexSide Mode is Map (the recommended method) or Add HexSide Mode is Form.  

- Add HexSide Mode is Map

1. Click on HexSide menu.
2. From the Hex Side window, select a style from the list, or create a new style.  Click Done when finished.
3.  Click on the hex side to apply.

- Add HexSide Mode is Form
1. Click on the HexSide menu.
2. Click on the hex you want to apply the HexSide.  The HexSide window will pop-up.
3. Select Add Hex Side to select the line style.

4. From the Hex Side window, select a style from the list, or create a new style.  Click Done when finished.
5.  From the Hex Side window, click on the sides to apply the line, then click Save.
6.  If you need to, add additional line styles.
7.  Click Done when finished.

Adding Secondary Map Features - Buildings, Woods, Cities, etc.

Symbol Editor
1.  Create a Mapboard symbol as a part of your symbol set.  Use the X-Image function for transparent 

areas.
2.  Save.

Map Editor
1.  From the Map Editor screen with a map already open, select Place Secondary Symbol from the 

Mapboard menu.
2.  Click on the location for the feature.

3.  Save.

Creating Grid Overlays

Symbol Editor Module

1.  Create a new Mapboard symbol to use as the grid overlay.
2.  Check X-Image.
3.  Set the primary drawing color to the desired grid line display color.
4.  Click the Draw Terrain Hex Side Lines button.

5.  Do not outline any of the other Mapboard symbols in the set.
Map Editor Module
1.  Set the overlay symbol.  From the Preferences menu, Select Map Overlay Symbol.  Pick the symbol 

you created, above. 

2.  Toggle the Grid On/Off.  From the Preferences menu, click Map Overlay is On/Off. 



Removing Map Features

Map Editor
1.  From the Map Editor screen with a map already open, Right click on the hex.
2.  To clear all features in the hex, click Clear Hex.
3.  To clear one feature, highlight the feature and click Clear Element.

4.  To clear the entire category of features (for example, all secondary symbols), click Clear Section after 
highlighting one of the features in the section.

5.  Click Exit to return to the map.

Adding PlaceNames

Map Editor
1.  From the Map Editor screen with a map already open, select PlaceNames.

2.  Click on the hex.
3.  From the PlaceNames window, chose the Font, Orientation, Color, Style, Symbol (Secondary Mapboard 

Symbol - not required), Size for each Zoom Level, and the text.
4.  Save.  If Preferences | Fast Scroll  is on, the PlaceNames may not appear on Zoom Level 1.

Play Game Module Actions

Create a New Game

You must first create the Unit and Mapboard Symbols along with the Mapboard for the game.  These must 

all be kept in a single Folder (usually named after the game) in the ADC2 |Gamesets Folder.
Play Game Module:
1.  Select File|New Game. You will be prompted to name the gameset and select a Mapboard.  Locate the 
gameset folder you want, open it and select the mapboard.  Read the help file that appears.

2.  Select Game | Auto-save and set the time to 5 minutes.
3.  Create the gameset .ops file.  Follow this sequence of for best results.  You can always edit any changes 
or errors at any time, but completion of all steps in this sequence will eliminate the possibility of having to 
edit large numbers of classes or pieces.  Save your work frequently.  Steps marked with * are necessary. 

Others may not be needed dependent on the game.

a.  Create Players
b.  Define Facing

c.  Create Classes*
d.  Create Flip Definitions
e.  Create Stack Symbol Definitions
f.   Create Pools

g.  Create Pieces* (recommend creating them in pools)
h.  Edit Turn Names
i.   Create Info-pages
j.   Set LOS Terrain Values and LOS Characteristics

k.  Set Game | Combat Summary Values (this is necessary to make the Combat Summary 
appear during play)
l.  Create Card Decks and Hands
m. Set Preferences (select Auto-Place Pieces from Pool if pieces are in pools)

n.  Place Pieces from pools on the mapboard*



Playing an existing game:

Play Game Module:  with 2 players, 

1.  Player 1 logs in.  
- Open the game file from the File Menu (*.ops), or click the Open file button
- Select the appropriate Player Name from the Log-In screen (automatically pops-up)

2. Select Next Turn/Set Turn from the Game menu and set the turn counter (if appropriate).

3.  Player 1 plays his turn.
- If playing by email, Player 1 saves this file and sends it to Player 2.

4.  Player 2 logs in.
- If player 1 is still logged in (a “hot seat” game), select Log-in as Another Player from the Game 

Menu 
5.  Player 2 plays his turn.
6.  Advance the Game turn counter (if appropriate) by selecting Next Turn/Set Turn from the Game 

menu.

7.  Player 2 saves the game and sends the file to player 1 (if playing by email).

Playing by Mail/eMail (PBM/PBeM)

General:

1.  One of the players makes the game symbols and creates the Mapboard for the game.  He then must send 
these gameset files to all the other players.  We recommend that when creating a new games you make 
a separate folder/subdirectory for it, and keep all of the files in this one location.  That way you can 
easily make sure you don’t forget to send any necessary files.  If you do get confused, a list of files and 

file types is included below, as well as elsewhere in the manual and in the First-Timer Help 
presentation.

Play Game Module:
1.  The first Player creates a new game, using the Mapboard file from above, making all of the necessary 

player definitions, facing styles, force pools, and piece classes.   He then creates and places all of his 
pieces according the the game set-up, and saves the game.   The saved game file (gamename.ops) is 
then sent to the next player (Player 2), along with any additional BMP or multimedia files Player 1 
may have added.

2.  Player 2 edits his player and class information as needed, creates and sets up his pieces, and saves the 
game.  Normally, you want to save the game to a new name after each player’s turn, so you can always 
easily go back to a previous turn (Example:  gamename1a.ops).  If Player 2 moves first, he can take his 
turn before saving.

3.  Player 2 sends the saved game file back to Player 1 (or the next player in a 2+player game) along with 
any additional BMP files or multimedia files he added.

4.  Player 1 views the replay, takes his turn, and saves the game. (Example: gamename1b.ops).
5.  Player 1 sends the saved game file back to Player 2 (Example: gametname1b.ops), plus any additional 

picture or multimedia files he added.
6.  Steps 4-5 are then repeated for each player, each turn.

Example:

For an example game called “wargame” these are the files that comprise the symbol and Mapboard sets, 
and need to be sent to all of the players before the game starts.  Files in bold always need to be 
included in the game set, the others are included only when a base Mapboard (“scanned-in map”) has 

been used.

wargame.set        (Data file that links the pieces and symbols)

wargame.sdx    (Symbol order file)

wargame-M1.bmp    (X-Image symbols - 3 files)

wargame-M2.bmp

wargame-M3.bmp

wargame-T1.bmp     (Mapboard symbols - 3 files)

wargame-T2.bmp



wargame-T3.bmp

wargame-U1.bmp     (Piece symbols - 3 files)

wargame-U2.bmp

wargame-U3.bmp

wargame.map (The Mapboard file)

wargame-Z1.bmp(“Scanned-in Map” - 3 files, when used)
wargame.Z2.bmp

wargame.Z3.bmp

The next series of  files are created during game set-up and play in the Play Game Module.  Only the .OPS 
file must be sent each turn - the others are sent only when (and if) they are first created.

wargame.ops        (The actual game setup or saved turn file)

wargame.ipx        (Info-Pages index. May or may not be present)
wargame.T#        (Info-Page, text type. One per page (#), when used)

wargame.B#        (Info-Page, .bmp type. One per page (#), when used)
wargame.C11.bmp (Card Decks - one set of 3 files for each deck, when used)
wargame.C12.bmp
wargame.C13.bmp

Note that some of these files may or may not be present, depending on whether you’ve used that particular 
function in your gameset.  If they are not present that’s fine.  If they are, they should be included in the 
initial groups of files you send to your opponent.  

Notice also that if you are including any custom .bmp files, such as a picture of yourself, you should send 
those as well.

Other files that might be present are those ending with .XET or .PRF.  These are temporary or local files 
and do NOT need to be included in a gameset.  

For larger games, you may need to compress the file before sending it, by using an archive program such as 

PKZIP or Winzip.

Adding Players

Play Game Module

1.  Click on Player from the New menu 
  or

Click on Player from the Edit menu, then on Add new player now 
  or

Click on Log in as New player from the Player Selection and Initial Log-In screen  (from either the 
opening game screen or Game menu) 
  or

Click on the Construct button.

2.  From the Player Information window, enter the new player name, and player-specific options.  You 
cannot delete Players from the list.

3.  Click Save.

Creating/Editing Force Pools

Play Game Module
1.  Click Force Pool from the New or Edit menu, 

  or 
Click on the Construct button.

2.  If creating a new Force Pool, click Make New Pool under the Pool Options.  

3.  If editing, select a Force Pool from the list.



4.  Select Add New Pieces to add pieces to the Force Pool.  The Add New Pieces to the Game window 
will pop-up.  Follow steps 1, 2  to add to the list, then click Place Now to add them to the Force Pool.

5.  Click Done/Cancel to save, or Place Now to add the pieces listed under List Selected for Action.

Creating/Editing Class Values

Play Game Module
1.  Select Class from the New menu or Edit menu, 

  or 
Click on the Construct button,
  or 

Double click in the Class column from the Select Pieces for Action window.

2.  If editing an existing Class, first select the Class.
3.  In the Edit Class Values and Information window, complete the entries - Class Name, Symbol, Facing 

style, Owning Player, Hidden Symbol.  Not all games will use facing and hidden symbols.  The facing 
style must first be defined using the Facing menu.

4.  Enter up to eight Class Value Names and any default Values.
5.  Either click Save or Edit another Class to remain in this window.  Click Quit to return to the play 

screen. 

Creating Piece and Assigning Values for New Pieces

Play Game Module

There are several methods to add pieces to the game:
1.  You can create pieces in pools.  This makes organizing them in terms of setup area or as reinforcements 

simple.  Open the pool you have created and click Add New Pieces.  Click the box for Automatically 
Edit each piece data as each piece is created if you need to assign piece values.  Select a class to 

make pieces from, select the quantity of pieces, click Add to List and then Place Now.  If you selected 
the Automatically Edit each piece data as each piece is created the Edit Existing Piece Values and 
Information form will appear.  Assign values as desired and click OK when completed.  The piece or 
pieces you have created will appear in the pool list.

2. You can add Pieces directly to the mapboard in addition to creating units in pools.
a.  Make sure Preferences | Auto Place Pieces from Pool is not checked.
b.  Click on the mapboard where you want the pieces to appear and then click the Add Pieces button 
on the Select Pieces for Action form.  You will see the Add New Pieces to the Game form. Click the 

box for Automatically Edit each piece data as each piece is created if you need to assign piece 
values.  Select a class to make pieces from, select the quantity of pieces, click Add to List and then 
Place Now.  If you selected the Automatically Edit each piece data as each piece is created the Edit 
Existing Piece Values and Information form will appear.  Assign values as desired and click OK 

when completed.  The piece or pieces you have created will appear.
3.  You can also use the New | Pieces menu or the Construct button New Pieces option to create, edit 
Piece Values and place pieces on the map.  When using these functions the operation is the same as 
described in above, except selection of the location of where the pieces will appear is made after you 

click Place Now.  You can still move the mouse around on the mapsheet.  After you position it where 
you want, click the spot and the pieces will then appear.

Using Facing

Play Game Module
1.  Create the facing styles for the game.  Click the Facing menu to bring up the Piece Facing Options 

window.
2.  Enter a new Facing Set Name and options.
3.  Click OK when finished.
4.  To apply facing styles to pieces, the piece classes must be first be set to those styles.  Edit or create the 

desired piece class.  From the Edit Class Values and Information screen, select the desired Facing 



Style and save the changes.  It is highly recommended that you set the facing style when creating the 
class as doing so will save a great deal of time.

5.  Click on the piece on the Mapboard.

6.  Double click on the Facing entry on the Select Pieces for Action window.
7.  Click on the facing direction, then OK.

Using Grid Overlays

Symbol Editor Module
1.  Create a new Mapboard symbol to use as the grid overlay.
2.  Check X-Image.

3.  Set the primary drawing color to the desired grid line display color.
4.  Click the Draw Terrain Hex Side Lines button.
5.  Do not outline any of the other Mapboard symbols in the set.
Map Editor Module

1.  Set the overlay symbol.  From the Preferences menu, Select Map Overlay Symbol.  Pick the symbol 
you created, above. 

2.  Toggle the Grid On/Off.  From the Preferences menu, click Map Overlay is On/Off. 
Play Game Module

1.  Toggle the Grid On/Off.  From Game menu, select Grid Display.  A check mark will appear next to 
this option when it is active.  

Using Cycling

Play Game Module
The cycling function will move through your pieces one at a time.  This will help you 
locate every piece, or, by selecting various options in the cycling window, locate every 

piece of a certain type or with particular attributes.  Click the arrows on the button bar, or 
Stop to stop cycling.

Using Hidden Pieces

Play Game Module

1.  Select either Player from the New menu 

        or 
Player from the Edit menu 
   or 
Click the Construct button and chose Edit Player Info. 

2.  Select Use Hidden Pieces from the Player Information window. 
3.  Assign a hidden symbol  (optional), and click Save when finished.
4.  Select Edit Class from the Construct button.

5.  Select the Hidden symbol style, and click OK when finished.

For a more detailed look at some of the combinations and options available with Hidden Units, see 
Appendix A:  Hints on Use.

Using Replay

Play Game Module

1.  To see the saved replay and all the accompanying comments, click the Replay menu, Show All.  
2.  Set the Replay options on the Replay Settings window, then click Begin Replay.
3.  After the replay, you can clear (delete) the saved replay, or continue to record each action.  From the 

Replay menu, select Clear Replay, and check the box in front of Clear Replay.  Note: Clearing the 

replay also clears the UNDO list.



Using text, pictures, videos, sounds

Play Game Module
1.  Click the comment button. 
2.  Select the type of comment to add.
3.  Enter the comment.

4.  Comments appear during the replay.  When the replay is cleared, the comments are also cleared.
* To save information for the duration entire game, or past the clearing of the replay, use the Info-Page 

menu to enter text or pictures.

Playing Cards

Symbol Editor Module
1.  Draw the cards as Piece Symbols (two standard card decks are included in ADC2).

2.  Save.
3.  Draw the playing surface as Mapboard symbols, and save to a separate file from the cards.
Map Editor Module
1.  Draw the playing surface from the Mapboard Symbols.

Play Game Module
1.  Create a new game from the File menu.  Use the playing surface file you created in the Map Editor 

Module.
2.  Select Deck from the Card menu.

3.  Pick the card symbol file you created.
4.  Select the content of the deck based on the symbols in the card file.
5.  Select Hands from the Card menu.
6.  Add new hands to the game.

7.  Return to the Deck menu to shuffle and deal the cards to each hand.
8.  Return to the Hands menu to play the card hands.

Placing Pieces on the Mapboard

Play Game Module
1.  Click on the Mapboard where you want to place the new piece(s) and select Add Pieces from the Select 

Pieces For Action window.
         or

Select Pieces from the New menu 
    or 
Click on the Construct button.  

2.  From the Add Pieces to the Game window, select the types of piece(s) to add, and the number of each 
piece to add.  Your cumulative selections will appear on the bottom right list.

3.  Click Place Piece Now button. 
4.  If you didn’t begin the operation in the Select Pieces For Action window, click on the board location to 

add the list of pieces.  Otherwise, the piece(s) are added to the original hex.
4.  If you place a piece in error, click Undo. 
5.  Click OK when finished. 

Rolling the Dice

Play Game Module
1.  Click the dice button.

2.  Select the number of die sides and the number of die to roll.
3.  Click Roll the Dice.



Printing

Play Game Module
1.  Board - Click Entire Game Board from the Printouts menu.

Screen - Click This Screen from the Printouts menu.
Pieces - Click Pieces from the Printouts menu.  
Classes - Click Classes from the Printouts menu.

2.  The pop-up window has several adjustable print options.

Adding/Removing Elevations 

Play Game Module

1.  Select Use Elevations from the Advanced menu.
2.  Set the elevation from LOS:Set Terrain Values on the Advanced menu.

Using Line of Sight (LOS)

Play Game Module
1.  Set the elevation and blocking points for each terrain type from LOS:Set Terrain Values on the 

Advanced menu.

2.  Set the general LOS defaults from LOS:Characteristics on the Advanced menu (optional).
3.  Select LOS on the Advanced menu, or click the right mouse button and select LOS.
4.  Select the LOS method:  either Area or Single (between two points on the board).
5.  Click on the spotting hex on the map. [S]

6.  If determining a Single LOS, select the target hex on the map. [T]  The cross sectional view of the map 
terrain will be displayed, along with the LOS results.

7.  If determining an Area LOS,  all blocked hexes will be marked [X].  Unblocked hexes will be marked 
[ ].

How to Select Units

Play Game Module
1.  Place mouse cursor over the unit/stack of units
2.  Left Click to open the Select Pieces for Action window

3.  Left Click on the unit you wish to manipulate.  Make sure your unit is the only unit with the “>>” 
symbol on the left.  The unit is now selected.

How to Edit a unit’s Piece Values while playing the game

Play Game Module 
1.  Select the unit.
2. Double Left Click on the unit somewhere within the limits of the dark blue band which highlights the 
unit in the “Piece Values” column.  This opens the “Edit Existing Piece Values and Information” window.

3.  Change the values or text as needed and click Okay.

Moving Pieces

Play Game Module

1.  Select the piece to move from the Select Pieces for Action window 
        or

Right-click on the piece and chose Move All Pieces from the menu.
2.  On the map, an [X] will appear on the starting hex of the piece(s) and each hex selected for move will be 

marked with a number [1], [2], etc. 
3.  Click OK from the map screen 
       or

Click the Right Mouse Button to complete the move.  

4.  A move flag will be added to the information window, and in the Select Pieces for Action window to 
indicate that these pieces moved.



Conducting Combat 

Play Game Module
1.  Select Combat: Set Summary Values from the Game menu, and pick the summary values for display. 

2.  Click on the pieces which will be involved in combat.
3.  From the Select Pieces for Action window, select the piece by clicking on the row (“>” will be 

displayed in the left column).
4.  Click on the Attack With or Defend With buttons.  A marker will be displayed on the map.

5.  Continue to select all attacking and defending pieces.
6.  When all pieces have been selected, click OK from the Play Game screen. The Combat Summary 

window will pop-up.
7.  If the Combat: Roll Dice Automatically  is checked, after closing the Combat Summary window, the 

Roll Dice window will pop-up.
8.  The attack and defend markers will be removed from the map, and attack and defend flags will appear 
on the information window and in the Select Pieces For Action window to indicate that these pieces were 
involved in combat.

SECTION 9:  TROUBLESHOOTING
The majority of problems stem from not using the most up-to-date patch file for ADC2. 
Visit www.hpssims.com to find the latest version of ADC2.

Problem - ADC1 symbols are not correct in ADC2:  

99% of all gamesets import without any problems into ADC2 format.  However, the exception is any set 
that has used any other color besides BLACK as a secondary color.  Therefore, if you have used other 
colors besides BLACK as secondary Mapboard symbol, that set will not import into ADC2 correctly. 
There is nothing to be done except get rid of the secondary Mapboard before importing.   Notice that ADC2 

has no such limitations on color usage except as noted above.

Problem - Symbols do not show on the map:
Check: Fast Scroll.  In the Mapboard Editor Module and the Play Game Module, if the selection Fast 

Scroll is active, then pieces, hexlines, hexsides, and PlaceNames are not drawn.

Solution:  Check Grid Overlay:  If the grid overlay was not drawn with the X-Image function, it will not be 
transparent and may be on top of your map.  Turn the grid setting off and see if the pieces and terrain 

appear.

Problems:
ADC2 version symbol conversion message even though it’s an ADC2 gameset

Error code-Could not open V1 terrain symbol
Error code- Loading Symbols
V1 Symbol Conversion Failed
Map is totally gray or white, but placenames and hexsides/lines are visible.

Solution:  Make sure you and your opponent are both using the most up-to-date version of ADC2  (or at 
least the same version).

Problems:
Unable to create or copy to make new symbols
Low resource error message
ADC2 runs slower and slower during an extended session

Replay crashes
Garbled Screen graphics

Solution:  Not enough available memory.  This has nothing to do with your system memory (ie, you might 



have 64 or 128 megs of RAM) but relates to how much is available for ADC2 for current use.  Many 
applications do not release memory even after they are terminated.   Computers also frequently have many 
programs running in the background.   The user may not even be aware of some of these programs, which 

can eat into available memory.    The best thing to do is to start ADC2 from a clean boot, and close down 
any unnecessary programs.    Some users have also reported problems that appeared to be video card 
related…when they updated their video card driver software with the latest version from the hardware’s 
web site, the problem went away.

Contacting HPS

We are interested in any comments, questions, or problems  you have regarding this program.  HPS 

Simulations can be contacted in the following ways:

World Wide Web at http://www.hpssims.com.  

Phone: (408) 554-8381.  
Fax: (408) 241-6886.  

Mail:

HPS Simulations
PO Box 3245 
Santa Clara, CA  95055

APPENDIX A: HINTS ON USING ADC-2

For more hints visit the ADC2 Hints and Tips Section at http://www.hpssims.com/ Support-ADC2.htm

Because of ADC2’s incredible flexibility, users are offered a wide variety of choices and latitude in 
designing games. However, there are a few tricks that often make the creation process easier - especially 
for new users.

Understand that Most ADC2 features are Optional! – One of the most important parts about using 
ADC2 is the fact that you DON’T need to know how to use every detail of ADC2.   Unlike a lot of 
software, ADC2 packs many, many features that will apply possibly to only a fractional percentage of 

games being played.  So don’t be overwhelmed by the plethora of options….if you don’t need to use 
something in the game you are making, don’t bother with learning its details.  Such items include piece 
status dots, importing data from databases, Line of Sight options, hidden units, etc.    The main things you 
will need to focus on are:  Make the symbols, make the map, put together the game itself.   What else you 

learn to use with ADC2 depends on what game you are trying to create.   

Planning - The first, and usually most important determination, is deciding how big to make your symbols. 
Unfortunately, there really isn’t a rule of thumb for what works best - it all depends on your game.  We 

strongly recommend that you make 1 or 2 very basic Mapboard symbols and a unit symbol before spending 
a lot of time making the complete set.  Then, create a “test” map and game using these symbols to see if it 
is what you want.  If it is, you can go back to the set and complete it.  If not, you can delete the original and 
start a new one, without having wasted a lot of time.

Size of hexes and pieces - Choosing the right zoom level size is a critical decision.  For most games, the 
unit symbols themselves need to FIT into the hexes (or squares) that you’ve chosen, otherwise you end up 
with a real mess.  True hexes add another wrinkle, since they have about a 1/3 reduction in usable space 

over the listed size.  For example, if you choose a size 60 x 60 true hex, only a 40 x 40 unit symbol will 
comfortably fit within the borders.  You should experiment with unit symbol sizes and terrain symbol sizes 



to verify what you need BEFORE committing yourself to making a hundred unit symbols.

Grab Colors whenever possible when making symbols - With 256 or more colors to choose from, it is 

sometimes difficult to positively identify which shades are which.  By grabbing a color (the eyedropper 
button), you can insure it matches what you already have.  You can also “store” colors in the primary and 
secondary colors boxes for future use.   You can place the mouse in the secondary color box and “grab” it 
into your primary box.  By right clicking, you can grab a color and place it into your secondary box. 

Additionally, you should notice that when you move the mouse over the color boxes, the number of the 
color will appear.  This will help you keep track of which hue you are using.  Make a note of the color 
number for future reference.

Colors - Make careful selections of colors when you are creating mapboard and unit symbols.  Remember 
that users will be viewing the mapboard for long periods.  It is best to avoid extremely bright, "electric" or 
"neon" colors as these can cause eye fatigue.  They can make other colors appear to vibrate.  Selecting 
colors that are too dark, on the other hand, can make locating pieces or important features difficult, and 

provide a poor background color for characters in placenames.  Remember that black lettering on a light 
background is the easiest to read.  Light colored characters on a dark background tend to blur.  It is 
important to make the pieces easy to spot on the mapboard.  This requires some contrast in both color and 
level of brightness.  If you overdo the color and/or the brightness contrast, the result will look garish and 

amateur.  Never use pure white as mapboard symbol color - even if the boardgame did.  How the eye reacts 
to a computer monitor is different than how it reacts to looking at a flat mapboard on a table illuminated 
from above.  Instead, use the Custom Color selection to select a very light yellow or green tint.  The 
Custom Color Selector is your greatest asset in getting the colors and the gameset to look good.  Consider 

changing the colors used in the actual game to better serve your needs.  Often publishers are limited in their 
printing to using only certain colors.  With ADC2 you can broaden the range of colors to make the gameset 
more attractive and easy to look at and use. 

Four pieces per hex, versus One - ADC2 offers the option of drawing either one of four pieces per hex 
(there is actually unlimited stacking, but only a limited number of symbol can be drawn due to space 
limitations).  Therefore, the size of the pieces will be very important in how the gameset looks.  If they are 
too large, they will “overlap,” especially when displayed four per hex.  If you know in advance that you 

will want to show four pieces per hex - we suggest making the pieces just under ¼ of the hex area, so all 
four will display without overlapping.  Where only a single piece will be shown, for best results you should 
make the piece size just less than the hex size.  An advantage to displaying one piece per hex is that the unit 
symbol can be larger, which allows for greater detail and overall better looking pieces.

3-D Pieces - As has been noted earlier, it’s easy to make a “functional” gameset quickly.  However, a 
gorgeous set does take a bit more time.  One of the easiest ways to spice up the look of your pieces is the 
use of “3-D” borders.  This light/dark shading technique really makes your piece counters stand out.  To get 

the “3-D” look, merely place an all-black border around your piece at Zoom 2 and/or 3  (normally, there’s 
not enough space to 3-D shade Zoom 1).  The border will make the piece stand out from the mapboard 
terrain it's placed on.  But it will still look "flat."  To correct this, place a second line inside the first, with 
one half a fairly dark shade, and the other half a very light shade. Use the buttons in practically any 

Windows 95/98 application as an example.  The piece counter now appears to be 3- dimensional and will 
look as if they are in fact separate objects on the mapboard.



Sample 3-D piece with actual size piece shown to right.

Map Borders - It is almost always a good idea to add two or three hexes in both directions to create a 
“border” around your map.  In some cases, you may wish to have  displays, game turn tracks, or other game 

aids displayed next to the map.  But, even if you don’t, the border gives a more professional look to the 
Mapboard, and provides a cushion in case you miscalculated the size  you need.  Remember, you can add 
or subtract from the width of the border even after creating the mapboard by opening the games and using 
the Play Game Module Advanced | Resize Board/Playing Area function.

A Map Edge Showing a Sample Game Turn Track

Railroads and rivers - A quick way to display fancier hexline and hexside graphics is to have a small line 

displayed inside of a larger one.  For example, for a railroad, you could have first line type of a narrow 
straight line, with a second line being dashed.  When combined, they look more like the standard “zipper” 
map symbol normally used for a railroad.  For a large river, you could have a thicker dark blue line, with a 
thinner light blue line laid “over” it on the map, etc.  If both a road and a railroad were in the same hex, you 

might consider having all the roads brown and the rail black, for example.  Make them different sizes and 
be sure to place all the larger lines first.

Fast-Draw turned on - The fast draw option will draw your Zoom Level 1screen much faster (especially 

for the REALLY big games), by leaving out Place Names, HexSides, and HexLines.  However, be 
warned…it also leaves out the pieces.  So if your game has invisible pieces at zoom level one, you probably 
have Fast Draw accidentally turned on.



The first Mapboard Symbol type - When making a new map, the map is filled with the first Mapboard 
Symbol type on the list of symbols available (that you have previously created using the symbol editor).  It 
is therefore very timesaving and convenient to make the first Mapboard type the same as the type of 

Mapboard most prevalent on your map.  If you are making a naval game, this might be a sea hex.  If you 
are making a gameset about combat on the Russian steppes, it might be clear Mapboard.  A gameset about 
the Battle of the Bulge, on the other hand, might be best served with having woods as the first Mapboard 
type listed. 

Save Often! - If you turn off the Autosave you do so at your own risk.  We hope this hint is self-
explanatory.

Gameset  Creation - When you make a gameset create a "Master.ops" or "Base.ops" file which you can 
use as a basis for various scenarios.  Make all the players, classes, flip definitions, etc., and create all pieces 
in appropriately named pools.  The more pools you make for specific pieces or groups of pieces the easier it 
will be to find the pieces you are looking for.  Think of it in terms of having extra counter trays with your 

boardgame which enable you to sort your counters better.  With up to 32,000 pools, you have a lot of 
options for sorting.  Separate pieces by player, setup area, or reinforcement turn/area.  Once you created the 
gameset but before you start placing units, save the "Master.ops" file (or whatever you named it), and then 
File | Save As the name of the game or scenario you want to make.  If a game has multiple scenarios, use 

the "Master.ops" file for each and save it for each of the scenarios, using the specific scenario name for 
each.  If Scenarios are sequential in nature, you might also consider creating the first scenario from the 
"Master.ops" file.  Then create the second scenario from the first, and so on.  Thinking and planning ahead 
can save a lot of time and tedious work.

Stacking and Piece Creation - There are a number of different ways to order units in a stack so that the 
piece you want is visible on top of the stack.  You can specifically designate a piece in the Edit Existing 
Piece Values and Information to "Draw this Piece on top of others."   You can also use the 

Game | Mapboard Display Options | Put Class on Top in Hexes option to designate an entire class to 
display on top.  You can also click on a stack of pieces and in the Select Pieces for Action form use the 
Sort Button.  However, if you are not going to need to constantly reorder your pieces using these methods, 
you can create pieces so that they always display in a specific order.  Pieces are displayed in reverse order 

of their creation.  So the first piece you create will always be displayed on top of other pieces when in a 
stack.  The last piece you create will always be display underneath and will probably not be seen.  In a 
hypothetical game you might want out of supply and other markers to always be on top, followed by 
leaders, armored units, and then infantry units.  Before starting to make the pieces, create pools with the 

categories you need and order the pools using the Edit | Pools | Set Display Order function.  This will 
make remembering the order in which you want to make your pieces simple.  In the hypothetical game, you 
might have pools which are listed in order:  Markers, Allied Leaders, Axis Leaders, Allied Armor, Axis 
Armor, Allied Infantry, Axis Infantry.  In a complex game you might have hundreds of pools at this point, 

but after all pieces have been made, you can consolidate your pools by making an Allied Pool and using the 
Transfer Pieces option in the Create or Edit Force Pools form.  After transferring the Allied Leader, 
Armor, and Infantry pieces to the new Allied Pool in our example, you can delete the empty pools you used 
initially. 

Hidden Units - There are several ways to implement hidden units in ADC2:

Area Hidden

This "area-based" method reveals the unit when an opponent's piece is within "X" hexes. You can get more 
details in the Help index by typing "hidden".

Set up:

1) Go to the Advanced menu
2) Make sure "Auto Reveal When Moving (Range): On"
3) Go to Edit/Players
    Perform the following on each of the two players (does not work with more than 2)  

    Choose a "player"



    Choose "Edit Selected Player Info" (click button)
    Go to "Search/Reveal Range"
    Set to whatever range you want to use.

    Go to "Hidden Piece Options"
     Made sure the following options are checked:
    "Use Hidden Pieces For this Player"
    "Pieces hidden when placed on board"

    "Pieces in force pools always hidden"
     Click on "Save"
     Click on "X" to close window
4) End of changes

Units spotted (revealed) will remain that way until the end of your turn, even if the spotting unit moves 
back out of range.  If you want the program to run the spotting routine manually, select 
Advanced |Run (Range) Auto-Reveal Now.

 
Hex Hidden

This method hides the identity of all units until selected for combat. To toggle this option On/OFF, select 
Advanced  | Reveal Pieces During Combat.  When this option is on, it has the following effects:

     a)  Any piece selected to attack is immediately revealed.  Other pieces that
         may be in the same hex, but that are not attacking, are not affected.
     b)  ALL pieces in a hex with at least one unit selected to defend are 
         immediately revealed - even if the pieces are not all selected to defend..

Set up:
1) Go to the Advanced menu
2) Make sure "Auto Reveal During Combat: On" (all other options off)

3) Go to Edit/Players
    Perform the following on each player
    Choose a "player"
    Choose "Edit Selected Player Info" (click on button)

    Go to "Hidden Piece Options"
    Made sure the following options are checked:
    "Use Hidden Pieces For this Player"
    "Pieces hidden when placed on board"

    "Pieces in force pools always hidden"
    Range setting is not applicable in this option
    Click on "Save"
    Click on "X" to close window

4) End of changes

LOS Hidden

The third method hides movement based on LOS (line of sight) from one unit to another depending on the 
elevation settings of the ADC2 module. It simulates playing a refereed game where a referee would control 
sightings.  In operation, this function first "hides" ALL of the pieces on the board,  then cycles through all 
the on-board pieces - each of which tries to sight every piece belonging to another player.  If the LOS is not 

completely blocked, the target piece is "seen".  Once a piece is seen - it is seen by all of the other players, 
no matter which player's piece spotted it.

Set up:

1) Go to the Advanced menu
2) Make sure all sighting options are off except "Auto-Reveal when Moving (LOS)
3) Make sure "Use Elevations" is on.  You must open and set the "LOS: Set Terrain Values" and  "LOS: 
Set Characteristics."  See below for further explanation.

3) Go to Edit/Players



    Perform the following on each player
    Choose a "player"
    Choose "Edit Selected Player Info" (click on button)

    Go to "Hidden Piece Options"
    Made sure the following options are checked:
    "Use Hidden Pieces For this Player"
    "Pieces hidden when placed on board"

    "Pieces in force pools always hidden"
    Range setting is not applicable in this option
    Click on "Save"
    Click on "X" to close window

4) End of changes

HOW TO ESTABLISH LOS PARAMETERS AND HOW THE LOS BLOCKING OF TERRAIN 

WORKS:

LOS - The key for using LOS in tactical games is dividing up your terrain types into Base Elevation and 
AGL (Above Ground Level) types.  Normally, your "base elevation" types will not have any AGL terrain 
features, while the AGL types will not have any base elevation.  For example, you would create base hexes 

such as 0 meters, 5 meters, 10 meters, etc. and AGL types such as woods, orchard, houses, etc.  A good 
technique for the base elevation symbols is to use a slightly different color for each elevation level. 
Generally, from lower elevation to higher elevation the color gets darker.  

Once you have all of your symbols completed, and the map drawn you are ready to go into the Play Game 
Module and "tell" it how to treat your terrain.   First, set the base elevation for all of your primary types. 
For the above example, you could set the base elevations to 0, 5, 10, 15, 20, etc. to match the height in 
meters.  Or, you could use an arbitrary system where a level represents some specified height (which is the 

situation in most board games).  In this case, you might set the base elevations to 0,1,2,3,4,5, etc., where 
each level actually represents 5 meters.    

Next, you would set the AGL heights of the secondary features - making sure to match the height per level 

with what you used for the base terrain.  For example, let's say woods are 5 meters high.  If in the preceding 
step you set the base elevations at 0, 5, 10, 15, etc., the height of the woods will be 5, based on 1 meter per 
level.  However, if you set your base elevations to 0, 1, 2, 3, 4, etc. the height of the woods will be 1, since 
in that system each level represents 5 meters.

There are several other points worth mentioning.  First, the unit of measurement is purely cosmetic, you 
can type in "furlongs" instead of meters, for example.  Second, you need to know the LOS rules of the 
game in order to accurately implement them here.  If the game utilizes "the plateau effect" (i.e., the 

map/board comes in flat increments, and LOS is blocked if the piece is in the "shadow" of the lower 
map/board) then you want to be sure to check the "AUTOMATIC GROUND LEVEL SMOOTHING" to 
“off”.  On the other hand, if you want to try something a little more advanced in whatever game you are 
playing, check this box to "on."  Automatic smoothing actually takes the different level hexes and 

interpolates them, making for more realistic LOS assessments.  When using automatic smoothing, the Cliff 
elevation box allows for cliffs, given they drop X amount of map/board levels.

Finally, the setting the block point quantity individually for various features is a way to have partial LOS 

obstruction, if desired.  If your game features "all or nothing" LOS, then set the block points to any amount 
(say, for example, 100) and just be sure that all blocking map/board has a value of 100 or greater.  For 
games with partial LOS obstruction, you can set the map/board blocking values to less than the overall 
blocking value, and this way, get partial obstruction.  Suppose you had a game where a piece could fire 

through one woods hex, but not two.  You could set the overall blocking value to 100, and the woods 
map/board value to 50.  It would therefore not be blocked for one woods hex, but the second hex would 
block LOS.  This is only an example, as this feature is very flexible and can be adjusted as desired.  Under 
range options, you can adjust the maximum range or leave it as unlimited.



This screen allows you to also give a special elevation advantage to the spotting or target hex location.  For 
example, in some games, a sniper might be on the second story of a building, although the building hex 
itself is ground level.  You could then give him a height advantage here per the rules of the particular game 

before checking the LOS.

HIDDEN MOVEMENT PROCESS:

-There are 4 choices concerning "auto-reveal" features under the Main
  Menu | Advanced selection:
    a) Run (Range) Auto-Reveal Now:  Runs the auto-reveal routine based on the detection ranges 

established for each player.

    b) Run (LOS) Auto-Reveal Now:  Runs the auto-revel routine based on establishing an LOS (Line Of 
Sight) between units. (See below)

    c) Auto-Reveal When Moving (Range) ON/OFF.  If this setting is ON, the auto-reveal (using player 
range values) will be run each time a hex is selected in a piece's movement path.

    d) Auto-Reveal When Moving (LOS) ON/OFF. If this setting is ON, the auto-reveal routine (using 
LOS) will be run each time a hex is selected in a piece's movement path. (See below)

Pieces owned by all players (such as markers) are never hidden (they are always seen by all players), and 

NEVER try to sight on-board pieces of any player.  If you are using turn record tracks or other holding 
boxes located in border areas, pieces placed here WILL try to sight on map pieces, which can lead to 
unexpected results/exposures of units near the edge.  One solution is to make a "border" around the actual 
map area with a ground elevation high enough to block this type of spotting activity.  

This also means that markers intended to be placed on pieces should be created separately for each player. 
Otherwise, enemy players will be able to see these markers all over the mapboard - even if the pieces 
themselves are hidden.  For example, if the game uses "out of ammo" markers for pieces that can't attack, 

an "out of ammo" class should be created for each player, rather than a single generic one. Cards that 
happen to be placed on the board never try to spot enemy pieces, nor can they be spotted.  This is true for 
either of the auto-reveal methods.

In practice, use of the LOS-based auto-reveal function will normally be Limited to medium sized games; 
the time required determining all of  the Line Of Sight's increases exponentially with the number of pieces 
in the game.

MORE ON LOS:

Run Auto-Reveal Now - to have all on-board pieces search for hidden enemy units in their search range.
Auto-Reveal When Moving - to have moving units automatically search for hidden enemy units each time 

you select a new hex for them to move to.

The Auto-Reveal routine detects hidden pieces based on the Search/Reveal  Range set as a part of the 
Player Information.  In a very large game, you may want to have Auto-Reveal When Moving turned off, 

and click Run Auto-Reveal Now at the end of your movement in order to save time.  However, you run the 
risk of a moving piece "accidentally" moving onto or through a hidden enemy piece.  For smaller games, 
the Auto-Reveal When Moving  should remain on, and enemy pieces will be revealed as you select each 
hex in the movement path.  Once revealed, pieces remain known until the auto-reveal is manually run by 

clicking Run Auto-Revel Now.

Use Elevations - This option can be checked as on or off.  If ON, the elevation of each hex will be 
displayed in the lower right hand information box.  The elevations for each Map/Board Symbol are defined 

using LOS: Set Map/Board Values.  Use LOS: Set Map/Board Values - to assign the Base Elevation, 
and Other Terrain Properties to a Map/Board symbol.  

Above Ground Level (AGL)  is the elevation of a feature above the ground level of a hex.  The ground 

level of a hex is always equal to the Base Elevation of its' Primary Terrain.  If there are Secondary Terrain 



types in the hex, they (and their Base Elevation) are ignored in determining the ground level.  However, 
should  the secondary types contain features with heights above ground level, these features will extend 
normally above the hex's ground level.  In addition to the Base Elevation, the Primary Terrain may also 

have an AGL (for example, to represent trees rising above the base elevation). 

AGL Display Color is the color used for the AGL terrain in the single LOS results display.  That way you 
can graphically see the terrain and AGL features.  Typically, shades of green are used for foliage (trees, 

woods, etc), gray or black for cities, etc.  In the display, ground level is always drawn as brown.

Blocking Points are a degradation of the sighting range.  The number of points required to totally block 
sighting is adjustable from the LOS: Characteristics window.  Whenever an LOS is determined to pass 

though this terrain feature, this number of blocking points will be added to the running total. 

% When Spotting Location is the percentage of normal LOS blocking points that will be added to the 
running total if this terrain type is in the spotting hex.  Normally, this will be a value close to 50%, 

assuming the spotter is in the center of the hex.

% When Target Location is the percentage of normal LOS blocking points that will be added to the running 
total if this terrain type is in the target hex.  Normally this will be a value close to 50%, assuming the target 

is in the center of the hex.

Adding Comments - Sequencing helps, for example, it’s best to have a .wav file start first, then display the 
.bmp file, then the text.  That way the .wav file is playing while the .bmp is being displayed.  Otherwise, 

the .bmp file will display but the .wav file will not play until the .bmp is gone.

APPENDIX B: Special Section:  Classes and Pieces

To create well-playing set, users need to know what Classes and Pieces are and how to use them to their 
best advantage.  This relationship is one of the most critical aspects of ADC-2, and for many players, also 
the most confusing.

To begin with, we’ll define and describe each:

Class:  A Class is a set of family characteristics which will be shared among one or more pieces.  These 
characteristics include the symbol which will be shown on the map, the player which “owns” the class, and 

up to eight static (unchanging) values.  Classes are “intangible”; they can never be directly placed on the 
Mapboard or a force pool.  

Piece:  A Piece is a tangible marker, made “from” a Class, which is placed on the map or in a force pool. 

In addition to the class information, each Piece may be given its own individual values.

As you can see from these definitions, you must create the class before you can make pieces of that type. 
This relationship is shown below:





“So, why use Classes - why not just create Pieces?”  
This is a common question about ADC2, and the answer is simple: using Classes makes creating a game set 

easier and faster.  The reason is that most games use multiple pieces of the same basic type, which all act 
the same in game terms.  For example, in chess there are 8 black pawns.  They look the same, move the 
same, and belong to the same player.  So, it just makes sense to define the black pawn type once (as a 
Class) rather than eight times - once for each piece.  The situation is even more striking for many board 

games.  For example, Monopoly has dozens of $100 bills, while the war game War In Europe has 
hundreds of German 6-5 Infantry Divisions.  In these cases, creating Classes is obviously a huge saver of 
time and effort compared to creating each piece individually.

However, there are times when only a single piece will be created for each class.  One example would be 
the King or Queen of each color in a chess set.  Another is in a wargame where each piece is known by it’s 
leader or commander, such as “Lee’s Brigade” or “Stonewall’s Brigade”.  In these cases, using classes 
provides no real benefit, since a separate class must be created for each piece.

So, how many classes do I need?

This is another common question, and the answer obviously depends on the game you are converting to 
ADC2, and your personal preference.  However, here are a few guidelines:

1) Count the number of different-looking pieces in the game, and create a class for each.  For 

example, in chess there are 12 (six pieces in 2 colors):  pawn, rook, knight, bishop, king and queen in 

black and white. 

2) Count the number of “functionally equivalent” piece types, and create a class for each.  In chess, 

this works out to the same number as above.  In more complicated games it may not, though;  Pieces 
that look the same may have different capabilities.  For example, two armored divisions may both use 
the same symbol, but one may be much more powerful than the other.  In this case, you’d need to 
create two classes - one for the weaker division and one for the stronger.

3) Decide if it is important to show cosmetic differences on piece symbols that are otherwise 

identical in type.  For example, if the game has historical unit ID numbers or unit leader names printed 
on the standard pieces, do these HAVE to be on the symbol?  Or, can these be saved as Piece Names? 

In most games these values do not HAVE to be on the piece, so it becomes a matter of personal 
preference whether to include them or not.  Obviously, it’s a lot more work to include them, since a 
separate symbol must be drawn for each piece.  Otherwise, a single “standard” class can be created, 
and the unit ID and leader entered as Piece Names (which show up in the piece ID window, but are not 

part of the symbol shown on the Mapboard).  The following example illustrates the two different ways 
of setting up classes:




